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1   Introduzione a QGIS 
QGIS nasce nel 2002 da un gruppo di volontari con lo scopo di fornire un visualizzatore di dati 
geografici facile e veloce come risposta all’impostazione “da esperti” di GRASS. Con l’evoluzione 
del progetto, emerse l’idea di usare QGIS come Graphical User Interface (GUI) di GRASS. 
QGIS è stato successivamente ampliato tramite estensioni che svolgono funzioni specifiche, dette 
plugins e attualmente è un applicativo che può essere utilizzato in maniera indipendente.
Diversamente da altri applicativi GIS piuttosto complicati, QGIS ha un’interfaccia grafica intuitiva 
che ne facilita molto l’utilizzo, con un’unica finestra in cui si trovano comandi, mappe e layers. 
Offre inoltre la possibilità di gestire dati di formati diversi (raster, vettori, servizi web, ecc.) e di 
interfacciarsi facilmente con altri software di gestione di dati geografici. 
QGIS è completamente Open Source ed è scaricabile gratuitamente dal sito ufficiale www.qgis.org
dove è inoltre possibile trovare un'ampia documentazione e tutorial sull'applicativo.
Ad oggi (Aprile 2015) l'ultima versione stabile di QGIS è la 2.8. Le versioni con il numero dispari 
sono considerate “di lavoro”, mentre quelle con il numero pari rappresentano avanzamenti di 
versione o riportano importanti migliorie.

1.1   Struttura delle dispense

In queste dispense verranno presentate le principali funzioni di QGIS e si darà la possibilità di 
applicarle nello svolgimento di un'esercitazione che porterà a identificare e analizzare nel bacino 
idrografico del torrente Bisagno (in provincia di Genova) le aree a maggiore rischio di dissesto
idrogeologico, con particolare riguardo ai centri abitati e alle infrastrutture di comunicazione.
In ciascuno dei capitoli seguenti verrà proposto un obiettivo generale e saranno illustrate le 
principali funzioni o comandi che permettono di raggiungerlo. Si chiederà quindi di sperimentare 
quanto letto sul caso di studio della val Bisagno, arrivando via via ad un processo di analisi sempre 
più approfondito.

I dati utilizzati per l'esercitazione sono per la maggior parte pubblici e scaricabili dal repertorio 
cartografico della Regione Liguria http://www.cartografia.regione.liguria.it/templateRC.asp?
home=0&itemID=30&level=1&label=REPERTORIO%20CARTOGRAFICO)

Mappa Formato Sistema di 
coordinate

Scala nominale Estensione Aggiornamento Sezione 
repertorio

Limiti amministrativi 
(Comunali, provinciali e
regionali)

Shape Gauss-Boaga
fuso Ovest

1:5000 Intero territorio 
ligure

2011 Carte di 
base/confini

Bacini Idrografici Shape 1:25000 Intero territorio 
ligure

2007 Carte 
tematiche/acque 
interne

Reticolo idrografico Shape 1:25000 Intero territorio 
ligure

2007 Carte 
tematiche/acque 
interne

Uso del suolo Shape 1:10000 Intero territorio 
ligure

2012 Carte tematiche/ 
pianificazione del 
territorio e catasto

Inventario dei fenomeni 
franosi (Progetto IFFI)

Shape 1:10000 Intero territorio 
ligure

2013 Carte tematiche/ 
informazioni 
geoscientifiche
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DTM - Modello Digitale
del Terreno da CTR

ESRI Grid 
(estensione
.asc)

1:5000 
risoluzione 5 m

Comuni che 
fanno parte del 
Bacino del 
torrente Bisagno

Dal 2007 Carte di 
base/quote e 
prodotti derivati

In particolare i dati predisposti per l'esercitazione (scaricabili insieme a queste dispense dal sito 
htttp://geomorfolab.arch.unige.it) sono stati “alleggeriti” per ridurre in questa fase i tempi di 
elaborazione. Viene inoltre fornita la scansione di una tavoletta in scala 1:25.000 dell'Istituto 
Geografico Militare 

1.2   Come si presenta QGIS
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Legenda

Risultati 
dell'interrogazione

Modulo di 
visualizzazione dati

Comandi principali di visualizzazione e interrogazione dati 

Informazioni sulla mappa visualizzata

Barra dei menu



1.2.1   Principali comandi di visualizzazione

Sposta mappa

Zoom a ingrandire e zoom finestra

Zoom a diminuire

Zoom alla massima estensione

Zoom al layer attivo

Zoom alla visualizzazione precedente

Zoom alla visualizzazione successiva

Ricarica la mappa (refresh)
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2  Impostare un progetto QGIS
Obiettivo: 

• Elaborare "a tavolino" un procedimento per affrontare il tema
• Predisporre “l'ambiente di lavoro”
• Caricare i dati e valutarne l'effettiva utilità
• Individuare l'area di lavoro

QGIS permette di visualizzare, analizzare, incrociare, interrogare, tematizzare e preparare per la 
stampa o la pubblicazione web mappe georeferenziate vettoriali e raster a diverse scale. Tali mappe 
vengono collegate, come layer sovrapposti, in una rappresentazione detta progetto. 
Teoricamente il numero di mappe che si possono aprire in un progetto non ha limite, in pratica è 
utile, prima di iniziare, valutare quali dati servono effettivamente per evitare di arrivare a progetti 
pesantissimi e confusi. 
In un progetto QGIS le mappe sono collegate e si lavora direttamente sugli originali, che ogni volta 
il software va a recuperare tramite il percorso. A questo proposito, prima di iniziare a lavorare con il
software è necessario:

 analizzare "a tavolino" il tema che si intende affrontare tramite GIS e farsi un'idea 
dei risultati che si vuole ottenere e dei dati e delle elaborazioni necessarie. 
Caricare in un progetto tutti i materiali disponibili per poi vedere cosa si può ricavare
nella maggior parte dei casi porta a riottenere i dati di partenza e a perdere un sacco 
di tempo.

 organizzare i dati che si intende utilizzare in una o più cartelle facilmente 
raggiungibili e riconoscibili, ad esempio:
E:\\QGIS\val_bisagno\mappe_raster\fiumi.shp   OK!
C:\Users\Pippo\Desktop\ file miei  & vari\università\giusti.shp   NO! (c'è un 
carattere speciale, una lettera accentata e il nome della mappa è troppo generico)

 fare un back up dei file originali, separato dalle cartelle di lavoro 

2.1  Il “piano di lavoro”

QGIS non da in automatico soluzioni ai problemi di un territorio ma risponde ad una serie di 
“quesiti”. Più precisi sono i quesiti che gli vengono sottoposti, migliore e più utile sarà il risultato. 
Per questo, prima di iniziare ad elaborare delle mappe è necessario preparare un “piano di lavoro”, 
ovvero uno schema degli obiettivi e dei passaggi da effettuare. Naturalmente non c'è un unico 
sistema, ma si può procedere in molti modi diversi. Di seguito si riportano alcuni spunti.

A quali informazioni vorrei arrivare? - ovvero quale è il risultato finale. E' importante ricordare che 
una cartina colorata non si dovrebbe considerare un risultato, se non si riescono ad interpretare e a 
utilizzare le informazioni che fornisce. Il risultato finale dell'esercitazione proposta potrebbe essere
la delimitazione delle aree a maggior rischio idrogeologico e una classificazione di queste in base 
ai diversi fattori di rischio.

Come posso analizzare il problema? - E' necessario individuare gli aspetti principali del tema 
trattato e le informazioni che li descrivono. Quali sono i fattori che possono provocare forme di 
dissesto idrogeologico? pendenza, geologia del territorio, uso del suolo, predisposizione 
all'erosione, episodi passati di dissesto, vicinanza di corsi d'acqua.... Quali sono gli elementi che 
potrebbero ricevere maggiore danno da un eventuale situazione di dissesto? Insediamenti, strade, 
aree industriali....

Quali dati mi servirebbero? - apparentemente i dati necessari ad un'analisi territoriale sono 
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moltissimi, in pratica alcuni forniscono informazioni simili, altri sono derivati, altri sono poco 
rilevanti... A cosa servono le curve di livello se è disponibile un DTM?  E' importante avere una 
carta geologica dettagliatissima lavorando in scala 1:50000?

Quali dati ho effettivamente? Alcune informazioni, sebbene utili, non sono disponibili, sono 
incomplete oppure richiederebbero troppo tempo o denaro. Bisogna quindi valutare la fattibilità del 
procedimento di analisi ipotizzato, semplificando dove è il caso oppure mettendo in conto di 
escludere alcune parti se le informazioni non sono sufficienti. I dati che ho a disposizione coprono 
tutta la mia area? Vale la pena di ripassare le carte IGM per avere l'estensione dell'urbanizzato 
agli anni '50? Ricalcare Google Earth è l'unico modo per ricavare l'uso del suolo?

Riconsidero il procedimento ipotizzato inizialmente alla luce dei dati disponibili, valuto se i risultati
attesi sono coerenti con quanto previsto in fase iniziale ed eventualmente faccio le correzioni 
necessarie. Riesco ad ottenere informazioni che prima non avevo o ridisegno “cose” già note? Mi 
servono veramente le informazioni che ricavo o è soprattutto un esercizio di abilità? Come potrei 
integrare i risultati?

Una volta elaborato un piano coerente e fattibile ci si può mettere al lavoro.

2.2  Impostare il sistema di coordinate del progetto

Per prima cosa, creando un nuovo progetto in QGIS è necessario impostare il sistema di 
riferimento (= sistema di coordinate) cui faranno riferimento tutte le mappe utilizzate.

Siccome siamo in Liguria e si lavora principalmente con dati regionali il sistema utilizzato è Monte 
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Mario / Italy Zone 1 con codice EPSG 3003

Importante, quando si imposta un sistema di coordinate in QGIS è attivare la funzione "abilita la 
riproiezione al volo", cliccando la casella in alto. In questo modo, tutte le mappe che si andranno ad 
aprire verranno automaticamente visualizzate nel sistema di riferimento scelto. Non verranno 
tuttavia convertite in tale sistema.

Esistono più di diecimila sistemi di coordinate, a coprire tutta la terra. 
Una principale divisione è data in:

 sistemi di coordinate geografiche (in cui la posizione di un punto è espressa da un 
angolo rispetto all'equatore (Latitudine) e un angolo rispetto al meridiano di 
Greenwich (Longitudine) e misurata in gradi decimali o sessagesimali

 sistemi di coordinate piane - dette anche proiettate, metriche o chilometriche - in 
cui la posizione di un punto è espressa dalla sua distanza dall'equatore e da un 
meridiano di riferimento ed è misurata in metri o in chilometri.

Esistono anche alcuni sistemi di coordinate polari (in cui la posizione di ciascun punto è espressa in 
una misura ed un angolo rispetto ad un punto di riferimento), ma sono meno utilizzati

In generali i sistemi di coordinate geografiche sono utilizzati a scala globale o territoriale molto 
vasta (ad esempio un intera nazione), mentre quelli di coordinate piane sono utilizzati a livello 
locale, perché presentano meno deformazioni. 

9



Ogni sistema di coordinate è descritto da 
 un nome (es. WGS84)
 una descrizione, che comprende l'elissoide di riferimento e nel caso di coordinate 

piane il sistema di proiezione utilizzato
 un numero univoco, detto codice EPSG (International Association of Oil & Gas 

Producers), che fa riferimento ad un database di sistemi di coordinate gestito e 
aggiornato da quest'associazione 

Nonostante la Liguria utilizzi il sistema di coordinate metriche Roma 40 Fuso Ovest (EPSG  3003)  
sistemi di coordinate più utilizzati in Italia sono:
WGS84 UTM32 Nord (coordinate metriche, codice EPSG 32632) utilizzato soprattutto per i dati 
regionali e quelli scaricabili dal Geoportale Nazionale)
ED50 UTM32 (coordinate metriche, codice EPSG 23032), utilizzato per gran parte della 
cartografia dell'Istituto Geografico Militare
WGS84 (coordinate geografiche, codice EPSG 4326) utilizzato per dati internazionali, ad esempio 
quelli ricavati dai satelliti Landsat

2.3  Caricare mappe vettoriali in un progetto QGIS

Una mappa vettoriale consiste in una serie di oggetti - punti, linee o poligoni - cui possono essere 
associati dati diversi, in forma tabellare. Ad ogni oggetto sulla mappa corrisponde una linea della 
tabella associata e sono collegati tramite un numero univoco definito automaticamente. Ogni 
mappa comprende un solo tipo di geometrie. Non possono quindi coesistere nello stesso layer 
punti e poligoni o punti e linee. I dato riportati nella tabella possono essere di quattro tipi:

 numeri interi (Integer, fino ad un massimo di 11 cifre)
 numeri decimali (Real, fino ad un massimo di 24 cifre, decimali compresi. Si tratta 

di numeri detti a " virgola mobile" e possono variare da parte intera di una cifra e 23 
decimali a una parte intera di 24 cifre e 0 decimali

 testo (String, fino ad un massimo di 254 caratteri)
 data (Data, in vari formati fino ad un massimo di 20 caratteri)

Diversamente da alcuni software di gestione di fogli di calcolo, tra cui Excel o simili, in ogni campo
(cioè colonna) della tabella possono essere contenuti dati solo di un tipo, ad esempio solo numeri 
interi, o solo decimali. Se si vuole mescolare numeri e testo, si deve utilizzare un campo testo.

QGIS apre e visualizza numerosi formati vettoriali, anche collegati a software proprietari, ma può 
modificare solo due tipi di file, i cosiddetti shapefile e i file creati tramite il database SQLite (o 
ancora meglio la sua versione "spaziale" Spatialite). 
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Altri formati vettoriali comuni (dxf, e00 di archinfo, gpx, file .TAB di Mapinfo, file KML di 
GoogleEarth, ecc.) possono essere aperti da QGIS in sola lettura e successivamente convertiti.

Cosa è uno Shapefile (detto anche “Shape”)
Si chiama shapefile un tipo di mappe vettoriali, originariamente prodotto dalla ditta ESRI e in seguito utilizzato come 
formato di interscambio tra i vari applicativi GIS, Open e proprietari. Una mappa vettoriale in formato shape è 
composta da un minimo di tre ad un massimo di sei file. 

 comuni.dbf   tabella associata alle geometrie
 comuni.prj    file in cui è registrato il sistema di coordinate
 comuni.shx   estensione della mappa nello spazio
 comuni.shp  file in cui sono registrate le geometrie della mappa
 comuni.qpj, comuni.sbx, comuni.sbn, ecc. altri file creati dall'applicazione con cui è stato salvato lo 

shapefile
Perché un software GIS possa leggere uno shapefile è necessario che tutti i file che lo compongono siano salvati nella 
stessa cartella e abbiano tutti lo stesso nome (naturalmente mantenendo estensione differente)

Per caricare in QGIS una mappa vettoriale:
Menu Layer => Aggiungi vettore=> Aggiungi vettore=>
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In alternativa si può cliccare sull'icona indicata nel cerchio rosso.

Viene quindi chiesto di indicare il vettore da aggiungere, con tutto il percorso

Selezionare il file o i file da aprire con estensione .shp (per gli shapefile)
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Confermare con "Apri" e successivamente con "Open". Se nello shape è presente un file .prj, QGIS 
legge il sistema di coordinate in cui è salvato il file e lo apre direttamente, se invece non è presente, 
come ad esempio in alcuni file più vecchi della Regione Liguria,, chiede di indicare manualmente il 
sistema di coordinate. Se il sistema di coordinate indicato è quello corretto, la mappa viene 
visualizzata nella posizione reale, se invece viene indicato un sistema di coordinate sbagliato, la 
mappa viene visualizzata traslata o deformata.
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Una volta caricata la mappa, comparirà in legenda il suo nome. Se la mappa non fosse visibile, 
selezionare il nome del layer in legenda e cliccare sull'icona “zoom al layer attivo”

2.4 Principali comandi di selezione e interrogazione dei dati

La prima operazione che si può compiere su qualsiasi mappa vettoriale è selezionare e interrogare 
(cioè accedere ai dati collegati) gli elementi che la compongono.
IMPORTANTE: Per compiere qualsiasi operazione su un layer è necessario prima selezionarlo, 
cliccando sopra il nome nella legenda. 

 Seleziona elementi Il comando seleziona permette di accedere a diversi modi di selezione

  

Selezionando con un rettangolo, un poligono o un cerchio vengono selezionati gli elementi che 
ricadono anche solo in parte entro il contorno. Per selezioni multiple bisogna selezionare 
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successivamente i singoli oggetto o gruppi di oggetti tenendo premuto il tasto Ctrl

per deselezionare è sufficiente utilizzare il pulsante 

 Interroga elemento - cliccando su un oggetto, sotto la lista dei layer appaiono i dati 

collegati a quell'oggetto. Per farli sparire basta cliccare in un punto vuoto della mappa. 
ATTENZIONE: i dati appaiono in ordine alfabetico, che non è necessariamente l'ordine con cui 
sono riportati i campi in tabella. Per visualizzarli come sono nella tabella è sufficiente cliccare con il
tasto destro sulla lista dei dati e selezionare "modulo vista geometria"

Per rendere quest'opzione permanente bisogna attivare la casella Apri modulo automaticamente 
sotto la lista dei dati

 Misura oggetti. Da questo comando si accede a diversi strumenti di misura

Il comando ha una sua utilità se si desidera misurare pochi 
oggetti, mentre non è da utilizzare per molti. Ad esempio non ha 
senso utilizzarlo per calcolare l'area di tutti gli edifici di un centro 
storico. Per questa funzione esistono infatti altre utilità descritte in
seguito. 
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Apri tabella attributi Il comando apre la tabella dei dati collegata all'intero layer

Selezionando una o più linee della tabella (cliccando sul numero a sinistra della linea) e poi sul 
pulsante  la mappa zooma automaticamente sugli oggetti selezionati.

Allo stesso modo, selezionando uno o più oggetti sulla mappa, le corrispondenti linee della tabella 
vengono selezionate.
È inoltre possibile selezionare degli oggetti dalla tabella utilizzando la funzione filtro in basso a 
sinistra.
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 in particolare sono importanti: 

Filtro colonne: permette, scegliendo una colonna della tabella, di selezionare quegli elementi che 
corrispondono ad una determinata condizione (ad esempio tutti i comuni in cui la popolazione è < 
200 persone)
Filtro avanzato: permette di effettuare query anche piuttosto complesse in linguaggio SQL tramite 
uno strumento che concatena le diverse condizioni (ad esempio tutti i comuni della provincia di 
Savona con meno di 200 abitanti, che non fanno parte della comunità montana Argentea...)

L'utilizzo di questi due filtri non è proprio immediato, ma nella funzione "filtro avanzato" si trovano
alcuni esempi della sintassi da utilizzare, che permettono di risolvere la maggior parte dei problemi.

2.5 “Colorare le cartine”, cioè assegnare uno stile alle mappe

Ogni volta che viene caricato un layer, QGIS assegna automaticamente uno stile (colore e spessore 
del contorno, colore e tessitura del riempimento, dimensione e forma dei simboli puntuali) che può 
essere successivamente modificato. 

Si clicca con il tasto destro sul nome del layer => proprietà=>stile

Si può quindi cambiare semplicemente colore al layer cliccando sul rettangolino Colore (1), o 
modificare riempimento e contorno (spessore, colore e tipo di linea) cliccando su Riempimento 
semplice (2). 

Sono inoltre presenti alcuni modelli di texture. Selezionandone uno (3) compaiono diverse opzioni 
per modificare il colore dello sfondo, la linea di contorno e gli elementi che compongono la texture 
(punti, tratteggio, ecc.). 
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Una volta definito uno stile è possibile aggiungerlo tra quelli predefiniti cliccando sulla voce Fill (4)
e successivamente su Salva (5).

C'è inoltre la possibilità di realizzare mappe tematiche, secondo diversi criteri, visibili nel menu a 
tendina che si apre cliccando sul pulsante in alto a sinistra (di default presenta l'opzione Simbolo 
singolo, ovvero nessuna tematizzazione)

Un tipo di mappe tematiche molto 
comune, è quello realizzato secondo il 
criterio Categorizzato, cioè che assegna 
uno stile diverso ad ogni voce che 
compare in una determinata colonna. 
Vengono ad esempio rappresentate in 
questo modo le mappe di uso del suolo.

Si seleziona dal menu a tendina Colonna la colonna secondo cui si vuole categorizzare la mappa

=> si sceglie il tipo di colorazione che si vuol dare alla mappa dal menu a tendina a destra (opzione 
di default Colori casuali)

=> si clicca sul pulsante Classifica
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Ad ogni classe viene assegnato uno stile, che può essere comunque modificato cliccando due volte 
sul simbolo. Aggiungendo o togliendo la spunta accanto al simbolo inoltre la classe risulta visibile o
invisibile. All'ultima classe non corrisponde nessuna voce in legenda e serve per rappresentare tutti 
gli oggetti eventualmente creati successivamente sulla mappa. Un'anteprima dello stile applicato 
alla si può visualizzare cliccando sul pulsante Apply. Successivamente, se il risultato è soddisfacente
si conferma cliccando su OK.
In QGIS lo stile è collegato al progetto e non alla singola mappa. Questo significa che per salvare 
uno stile, non basta salvare la mappa cui è applicato, ma è necessario salvare anche il progetto 
QGIS. Inoltre, aprendo la stessa mappa in un altro progetto, questa avrà uno stile di default. E' 
possibile però salvare lo stile come file esterno e applicarlo alla mappa quando questa viene caricata
in un progetto nuovo.
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Per applicare ad una mappa uno stile salvato è quindi necessario 
cliccare sul pulsante Stile => Carica Stile selezionare lo stile desiderato. 
E' importante però ricordare, che se si tenta di applicare uno stile ad una mappa con caratteristiche 
diverse (ad esempio un numero diverso di classi, colonne con nomi differenti, ecc.), il programma 
va in crash.

2.6 Esportare una mappa vettoriale

Le mappe aperte in QGIS, indipendentemente dal formato originario, possono essere salvate con 
nome ed esportate in numerosi formati. Questo procedimento generalmente si utilizza per: 

• creare una mappa di lavoro, da modificare salvaguardando l'originale (ad esempio se si 
prevede di modificare geometrie o dati in tabella)

• riproiettare una mappa in un sistema di coordinate specifico (ad esempio assegnare il 
sistema di coordinate Monte Mario ad una mappa originariamente in WGS84)

• creare una copia modificabile una mappa originariamente in sola lettura (ad esempio un file 
KML di Google Earth o E00 di ArchInfo)

• creare una mappa che contenga solo una parte dei dati originari

Menu Layer => Salva con Nome  si apre la finestra “salva i vettori come...”

=>  scegliere il formato in cui salvare la mappa. Il formato più comune è ESRI shapefile, si possono
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comunque salvare mappe in numerosi formati, tra cui .kml da visualizzare in Google Earth, .dxf da 
aprire in AutoCAD (non in tutte le versioni e perdendo gli attributi associati), gpx, da caricare sui 
dispositivi GPS più comuni, ecc.
=>  cliccare su Sfoglia, scegliere dove salvare la nuova mappa e scrivere il nome. ATTENZIONE: 
se si scrive direttamente il nome dalla nuova mappa nella finestra Salva con nome, il programma da 
errore e non salva la mappa
=> scegliere il sistema di riferimento in cui salvare la mappa. Si può scegliere tra il sistema in cui è 
impostato il progetto, il sistema originale della mappa o un sistema di riferimento a scelta 
(cliccando sull'icona con il globo)
=> spuntando l'opzione “Aggiungi il file salvato sulla mappa” la mappa salvata verrà caricata nel 
progetto come nuovo layer, se non si spunta verrà semplicemente salvata nella cartella scelta
=> confermare cliccando su OK

Se si vuole creare una mappa che contenga solo un sottoinsieme degli elementi della mappa 
originale, si selezionano sulla mappa gli oggetti desiderati e dalla finestra Salva i vettori come… si 
spunta l'opzione Salva solo le geometrie selezionate. (quest'opzione si attiva solo se sulla mappa da 
salvare ci sono degli elementi selezionati)

2.7 Rimuovere una mappa dal progetto

Se si vuole rimuovere una mappa caricata nel progetto bisogna selezionare in legenda il nome della 
mappa , cliccare con il destro e selezionare “rimuovi” dal menu a tendina. In questo modo la mappa 
è rimossa dal progetto, ma non è cancellata dal PC. Per eliminare definitivamente una mappa è 
infatti necessario aprire la cartella in cui è salvata e gettarla via manualmente. Nel caso di shapefile,
tutti i file che compongono uno shape andranno cancellati.

2.8 Salvare un progetto QGIS

Un progetto QGIS si salva cliccando sull'icona . Se è la prima volta che lo si salva, il comando

corrisponde a "salva con nome", altrimenti semplicemente "salva". In pratica viene registrato un file
piuttosto leggero che tiene però memoria dei layer caricati, della loro posizione nel PC, dei loro 
stili, dei sistemi di riferimento e al momento della riapertura va a cercare tutti i suoi componenti. 
Quindi, se si rinominano o si spostano dei file, al momento della riapertura comparirà un 
messaggio di errore che avvisa che non trova uno o più componenti. QGIS da la possibilità di 
indicare il percorso o il nome corretto, ma è sempre meglio evitare di trovarsi in questa situazione 
perché, soprattutto per progetto complessi è facile perdere dei dati. Prima di salvare, comunque, è 
sempre meglio accertarsi nella finestra delle proprietà del progetto (menu progetto => proprietà 
progetto) che QGIS faccia riferimento al percorso relativo dei file e non a quello assoluto.
Esempio: 
percorso assoluto:
E:\Disco_F\lavori_in_corso\corsi\corso_2015\materiali\Comuni_5000\Comuni_1.5000.shp
percorso relativo:
..\corso_2015\materiali\Comuni_5000\Comuni_1.5000.shp
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2.9   Compito a casa:

• Impostare un progetto in Monte Mario fuso Ovest
• Caricare le mappe relative a 

- Comuni
- Bacini Idrografici
- Idrografia
- Uso del suolo
- Inventario dei fenomeni franosi (IFFI)
- edificato
- strade 

• Selezionare e salvare come nuova mappa il bacino del torrente Bisagno (quello che passa 
per Genova!)

• salvare il bacino del torrente Bisagno come nuova mappa in coordinate WGS84
• Selezionare e salvare come nuova mappa i Comuni il cui territori è compreso totalmente o in

parte nella Val Bisagno
• Organizzare le mappe nel progetto suddividendole in gruppi e assegnando loro uno stile 

“esplicativo”
• Salvare il progetto
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3 Elaborazioni con mappe vettoriali
Obiettivo: 

• Delimitare un'area di lavoro precisa
• Identificare gli elementi rilevanti
• Identificare le relazioni tra gli elementi delle diverse mappe
• identificare le relazioni tra i dati associati alle diverse mappe

Come la maggior parte dei software GIS, in mancanza di istruzioni in proposito, QGIS lavora sulle 
mappe intere e non sui singoli elementi. Se da una parte questo permette di evitare operazioni 
manuali lunghe, ripetitive o con alta possibilità di errori (ad esempio calcolare l'area per 10000 
poligoni) e gestisce bene i dati a scala territoriale, dall'altra c'è il rischio di produrre informazioni 
inutili o ridondanti con tempi di elaborazione lunghi e un notevole utilizzo della memoria RAM. Per
ottenere risultati effettivamente utili e ridurre i tempi di lavoro è quindi necessario stabilire alcune 
“condizioni” che affineranno il lavoro del software. 
In quale area si dovrà lavorare? Conviene per prima cosa individuare, anche a grandi linee, l'area di 
effettivo interesse. Utilizzare un sottoinsieme di una mappa (come visto nel capitolo precedente) è 
un primo passo che va ulteriormente affinato. É inutile effettuare elaborazioni su un'intera regione 
se si deve svolgere un lavoro relativo ad un'area molto più piccola.  Inoltre, nel caso di un'analisi 
del dissesto sarà utile considerare un confine fisico, piuttosto che amministrativo ed evidenziare 
quanto succede al suo interno escludendo il resto.
Quali oggetti mi interessano? Una mappa molto complessa può essere poco chiara e far perdere di 
vista l'obiettivo finale del lavoro. Occorre quindi fare una distinzione tra elementi principali e di 
contorno ed impostare il lavoro in maniera “ordinata”. Una mappa che riporta solo edificato e aree 
in frana può apparire meno completa e meno “bella” di una CTR a colori, ma evidenzia una 
situazione di rischio potenziale e aiuta a porre le basi per capirla. Successivamente si potranno 
aggiungere e includere nell'analisi altre informazioni
Quali informazioni collegate agli oggetti sono effettivamente importanti? Ad un vettore si possono 
teoricamente associare moltissimi dati, tuttavia è necessario capire quali e in che momento del 
processo di analisi sono necessari. Va tenuto conto inoltre che queste informazioni nella maggior 
parte dei casi non sono dinamiche, cioè non si aggiornano con la geometria e quindi possono anche 
essere fuorvianti... Solo metà di un comune è inclusa nel bacino che sto analizzando, ma il dato 
relativo alla popolazione fa riferimento a tutto il comune. Mi serve davvero portarmelo dietro? Non
posso proprio fare a meno della colonna con il nome del parroco?

Nella parte precedente sono stati caricati nel progetto i dati necessari, adesso vengono preparati per 
essere utilizzati al meglio.
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3.1 Strumenti per lavorare con i vettori

Il plugin fTools è uno strumento che permette di effettuare le più comuni elaborazione su base 
vettoriale, in particolare offre funzioni di ricerca, analisi, geoprocessamento, gestione dati. fTools è 
installato di default nelle nuove versioni di QGIS e, prima del primo utilizzo va abilitato nel gestore 
dei plugin (plugins=>gestisci ed installa plugin => installati  accertarsi che la casella 
corrispondente a fTools sia contrassegnata). 

Una volta abilitato, fTools aggiunge una serie di strumenti al menu a tendina che appare 
selezionando la voce “vettore”.
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3.2 Seleziona per posizione

Il comando “Seleziona  per posizione” (vettore => strumenti di ricerca => selezione per 
posizione) permette di selezionare gli elementi di interesse di una layer in base alla loro posizione 
relativa ad un altro layer: crea una nuova selezione oppure aggiunge/sottrae alla selezione corrente. 
La selezione creata poi può essere salvata come nuovo layer come visto nel capitolo precedente.
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Con questo comando vengono selezionate tutte le geometrie che anche minimamente 
intersecano la geometria selezionata. L'ordine in cui si scelgono i layer fa variare il risultato.

3.3 Vari tipi di overlay

Per “overlay” si intende un tipo di processo che permette di ottenere un vettore attraverso l'incrocio 
di due layer vettoriali originari; la tabella associata alla mappa risultante conterrà i campi di 
entrambe le mappe geo-processate.
Esistono differenti tipi di overlay, a seconda del risultato che si vuole ottenere.
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I comandi sono accessibili selezionando Vettore=>Strumenti di Geoprocessing.
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3.3.1 Intersezione - “overlay AND”

Il comando Vettore=>Strumenti di Geoprocessing => intersezione  
permette di intersecare due layer restituendone uno nuovo che contiene solo le geometrie comuni 
ad entrambi i layer originari. Il vettore in ingresso può contenere linee o poligoni mentre il 
vettore di intersezione soltanto poligoni. 

La mappa risultante consiste quindi in un “ritaglio” di quelle originarie. L'ordine in cui sono inseriti 
il Vettore in ingresso e il Vettore di intersezione non cambia il risultato
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3.3.2 Unione - “overlay OR”

Il comando Vettore=>Strumenti di Geoprocessing => unione  
permette di unire due layer restituendone uno nuovo che contiene tutte le geometrie di entrambi i 
layer originari. Sia il vettore in ingresso che quello di unione devono contenere soltanto poligoni. 

La mappa risultante consiste quindi in una somma di quelle originarie. L'ordine in cui sono inseriti 
il Vettore in ingresso e il Vettore di unione non cambia il risultato
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3.3.3 Differenza - “overlay NOT”

Il comando Vettore=>Strumenti di Geoprocessing => differenza  
permette di effettuare una sottrazione tra due layer restituendone uno nuovo che contiene le 
geometrie del primo layer a cui vengono tolte quelle del secondo. Sia il vettore in ingresso che 
quello di unione devono contenere soltanto poligoni. 

Il vettore in ingresso è il vettore a cui si vuole sottrarre l'area del vettore di differenza.
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3.3.4 Differenza simmetrica - “overlay XOR”

Il comando Vettore=>Strumenti di Geoprocessing => differenza  simmetrica
permette di effettuare una sovrapposizione di due layer restituendone uno nuovo che contiene la 
superficie dei due layer di input tranne la loro intersezione. Sia il vettore in ingresso che quello di 
unione devono contenere soltanto poligoni. 

La mappa risultante consiste quindi nell'inverso dell'intersezione di due mappe. L'ordine in cui sono
inseriti il Vettore in ingresso e il Vettore di intersezione non cambia il risultato 

31



3.4 Dissolvenza

Il comando Vettore=>Strumenti di Geoprocessing => dissolvenza
permette di dissolvere i confini tra i poligoni adiacenti di un layer, in base ai valori di un campo a 
scelta (campo di dissolvenza). I poligoni con lo stesso valore sono “fusi” in un unico poligono

Ai poligoni ottenuti tramite dissolvenza viene 
associata la prima riga della tabella, tenendo 
conto del campo di dissolvenza. Se nel menu a 
tendina si seleziona l'opzione “dissolvi tutto” 
tutti i confini interni verranno dissolti, a 
formare un unico poligono
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3.5 Buffer

Il comando Vettore=>Strumenti di Geoprocessing => buffer
crea un buffer (un'area) intorno agli elementi di un layer dato, ad una distanza indicata o sulla 
base dei valori di un campo (numerico). Si può creare un buffer attorno a punti, linee o poligoni e 
la mappa risultante sarà sempre un layer di poligoni. 

 Maggiore è il numero indicato nella 
casella Segmenti da approssimare, più 
le chiusure dei buffer saranno 
approssimate ad archi. In generale il 
valore assegnato di default è 
accettabile. 

Attenzione! Se non si spunta l'opzione 
“dissolvi il risultato del buffer” la 
mappa risultante consisterà in una serie 
di poligoni spesso sovrapposti fra di 
loro, quindi geometricamente non 
corretta. Effettuare elaborazioni su di 
essa (overlay con altre mappe, ecc.) 
sarà pertanto impossibile o porterà a 
risultati con errori.

Buffer non dissolto Buffer dissolto
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3.6 Unire mappe vettoriali

Il comando unisci shapefiles (vettore=>strumenti di gestione dati=>unisci shapefiles), consente di 
unire due o più vettori dello stesso tipo  (punti, linee, poligoni) in un unico layer. 

Non è necessario che le mappe da 
unire siano caricate nel progetto 
QGIS, infatti il comando chiede di 
scegliere al cartella in cui questa 
sono salvate. Di default vengono 
uniti tutti i file presenti in una 
determinata cartella, se invece si 
desidera unirne solo qualcuno è 
necessario spuntare l'opzione Scegli 
vettori nella cartella e selezionarli 
tenendo premuto il tasto Ctrl.
La tabella collegata alla mappa 
risultante conterrà tutte le colonne 
delle mappe che sono state unite. Se 
più mappe hanno colonne con lo 
stesso nome, queste verranno 
considerate una volta sola.
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Attenzione!!!!  Se le mappe 
da unire hanno parti comuni, 
nel layer risultante saranno 
presenti poligoni 
sovrapposti e non sarà 
geometricamente corretto. 
Sarà quindi inutilizzabile per 
ulteriori elaborazioni. In 
questo caso, non conviene 
utilizzare questo comando ma
piuttosto unire le mappe due 
a due con il comando 
Vettore=>Strumenti di 
Geoprocessing => unione  e 
quindi pulire le tabelle 
aggregate.

3.7 Unisci attributi per posizione

Il comando unisci attributi per posizione (vettore=>strumenti di gestione dati=>unisci 
shapefiles), consente di trasferire gli attributi degli elementi di un layer agli elementi di un altro, 
sovrapposti ad essi. Questa situazione si verifica ad esempio quando si desidera trasferire i dati 
associati a waypoints rilevati sul terreno alle aree in cui tali punti sono contenuti. 

Vettore target :layer a cui si desidera 
trasferire i dati
Unisci vettore: layer i cui dati devono 
essere trasferiti
Attivare l'opzione Prendi gli attributi 
della prima geometria per conservate 
tutte le colonne delle tabelle associate 
ad entrambi i layer
Nel caso in cui la corrispondenza tra 
gli elementi dei due layer non sia 
perfetta (numero di geometrie 
differente o sovrapposizione solo di 
alcune), conviene attivare l'opzione 
Mantieni solo i record corrispondenti. 
La nuova mappa conterrà solo gli 
elementi sovrapposti. In caso contrario
si potrebbero avere linee di tabella non
collegate ad alcuna geometria o 
geometrie senza attributi.

35



Unendo alle aree (vettore target) i dati collegati ai punti si ottiene un vettore di poligoni cui è 
associata una tabella contente le colonne delle due tabelle originarie.

3.8   Compito a casa:

• Ritagliare comuni, idrografia, uso del suolo, fenomeni franosi sul bacino del torrente 
Bisagno, accertandosi che le tabelle collegate non contengano dati inutili o sbagliati (codici 
incomprensibili, area di parti tagliate, ecc.)

• aggregare i comuni per provincia e controllare che le tabelle siano coerenti
• ricavare una mappa della parte di Provincia di Genova che non ricade nella Val Bisagno 

(divisa per comuni e aggregata)
• aggregare la mappa dell'uso del suolo del bacino del Bisagno per principali categorie (aree 

boscate, zone agricole, aree urbanizzate + infrastrutture di trasporto, ecc.)
• associare i dati delle frane nel bacino del torrente Bisagno alle relative perimetrazioni
• ricavare un buffer di 50 m dai corsi d'acqua
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4 Elaborazioni sui raster
Obiettivo:

• Visualizzare e interpretare mappe raster

Un'immagine digitale raster consiste in una “matrice di celle”, in pratica una scacchiera composta 
da quadratini tutti uguali detti pixel. Un esempio di immagini raster sono le fotografie digitali. Se si 
ingrandisce una fotografia si può osservare che oltre un certo livello di zoom l'immagine si “sgrana”
e diventa meno leggibile fino a mostrare una serie di quadratini affiancati di diverso colore. In un 
GIS si utilizzano spesso immagini raster: si va dalle foto aeree o satellitari, ad alcuni tipi di Carta 
Tecnica Regionale alle scansioni di carte o altri documenti storici, ecc.
In una mappa raster, ogni pixel è caratterizzato da:

• posizione – il punto centrale di ogni pixel, in un GIS è caratterizzato da una latitudine e 
longitudine, espresse in metri o gradi a seconda del sistema di riferimento (Monte Mario, 
WGS84, ecc.)

• dimensione – ogni pixel è un quadratino il cui lato ha dimensioni “reali”, espresse nell'unità
di misura utilizzata nel sistema di riferimento della mappa.  La dimensione dei pixel è 
espressa dalla “risoluzione” dell'immagine: un'alta risoluzione corrisponde a pixel di piccole
dimensioni e l'immagine appare più nitida ma occupa più spazio su disco. Ad esempio nelle 
fotografie satellitari ad alta risoluzione della Regione Liguria, ogni pixel è un quadratino di 
60 cm di lato e la foto relativa ad un territorio esteso circa 75 ha occupa circa 350MB

• un'altra proprietà variabile – ad ogni pixel di una mappa è associato un valore che può 
rappresentare grandezze diverse. Ad esempio, in un DTM (Modello Digitale del Terreno), ad
ogni pixel è associata la quota sul livello del mare, in una mappa delle temperatura, ad ogni 
punto è associato il corrispondente valore in gradi, ecc.

A seconda del formato alcune mappe raster hanno codificato al proprio interno un sistema di 
coordinate, altre invece devono essere associate ad un apposito file di coordinate (world file)
I formati raster che è possibile utilizzare in ambiente GIS sono moltissimi. In generale per ortofoto, 
immagini da satellite e carte topografiche si utilizzano i formati tiff o geotiff (nel caso in cui il 
sistema di coordinate sia già codificato nel file) o, soprattutto in passato, ECW1. Per i modelli 
digitali del terreno, ovvero le mappe che contengono informazioni relative alla quota e permettono 
quindi di lavorare in tre dimensioni, comunemente si usano invece vari formati di tipo grid (.dat, 
.xyz, .asc, grd, ecc.). QGIS, comunque riesce a leggere e ad utilizzare la maggior parte dei formati 
utilizzati, anche senza che un operatore sappia come sono codificati. 

1 - In effetti, siccome il formato ECW (Enhanced Compression Wavelet) è di proprietà della ditta ERDAS, QGIS non li 
importa direttamente, ma è necessario o trasformali prima in un formato open, ad esempio tiff, oppure installare alcune 
componenti aggiuntive.
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4.1 Importare una mappa raster

Per caricare una o più mappe raster, si clicca sull’icona Aggiungi raster  (nel tondo rosso)
oppure dal menu Layer => Aggiungi layer =>Aggiungi raster. 
Si aprirà la finestra Apri un formato raster supportato da GDAL da cui scegliere le mappe raster da 
caricare. Si possono caricare più raster contemporaneamente tenendo premuto il tasto Ctrl o Shift e 
cliccando su più elementi.
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4.1.1 Distribuzione dei valori in una mappa raster

In ambiente GIS si possono distinguere due tipi principali di mappe raster,  a valori discreti o a 
valori continui.
Nel primo caso i valori del raster sono pochi e identificano una serie di oggetti ben riconoscibili, ad 
esempio manufatti (edifici, strade, acquedotti, ecc), entità giuridiche (stati, comuni, proprietà, ecc.)  
oppure classi uniformi di dati, che hanno un limite individuabile. Un altro esempio molto comune di
mappe a valori discreti sono quelle basate sulla presenza o assenza di un determinato elemento: ad 
esempio i pixel in cui l'uso del territorio è “uliveti” hanno valore 1, tutti gli altri hanno valore 0)

Esempio di Carta Tecnica Regionale in scala 1:5000. Le parti in bianco hanno valore = 0, quelli in 
nero valore =1

Nel secondo caso i raster sono associati a condizioni o fenomeni che si manifestano su tutto il 
territorio (come l’altitudine, la temperatura, la pendenza del suolo, ...) e non hanno limiti 
individuabili. Un esempio di mappa raster a valori continui è una foto aerea (ad ogni pixel è 
associato un valore che identifica il colore), un Modello Digitale del Terreno (ad ogni pixel è 
associato il valore della quota),  ecc. I valori possibili per il raster andranno teoricamente da meno 
infinito a più infinito ed è molto difficile individuare aree con caratteristiche uniformi e confini ben 
definiti.
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Esempio di Modello digitale del Terreno (Digital Terrain Model, DTM). Ogni pixel è un quadrato di
lato pari a 5 m. Le parti più chiare indicano le quote più elevate.

Alcune parti di una mappa raster inoltre possono avere valore nullo, questo significa che in quelle 
parti non esiste nessun pixel. 

ATTENZIONE!!! Un pixel con valore = 0 NON E' LA STESSA COSA di un pixel con valore 
nullo!!!!  Un esempio un po' approssimativo potrebbe essere il caso in cui, in una mappa delle 
temperature viene assegnato valore = 0 ai punti in cui la temperatura è uguale a 0°, mentre le parti 
con valore nullo sono quelle in cui la temperatura non è stata rilevata.

4.1.2 Quali informazioni mi può offrire un raster?

Ogni mappa raster caricata ha incluse una serie di informazioni relative al sistema di coordinate in 
cui è stata creata, all'estensione, alla sua risoluzione (ovvero alla dimensione dei pixel che la 
compongono), ai valori riportati (ad esempio quota minima e quota massima), alla presenza di 
valori nulli. Per accedere a queste informazioni:

Raster => Miscellanea => Informazioni

=> file di ingresso dal menu a tendina si sceglie il raster su cui si vogliono ottenere le informazioni.
E' possibile anche ottenere informazioni su raster non caricati nella mappa cliccando sul pulasnte 
scegli e andando a cercare i raster nelle cartelle in cui sono salvati

=> OK

Le informazioni sul raster vengono visualizzate nello spazio “Informazioni raster”. In particolare:

• Pixel size indica la risoluzione
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• Upper Left, Lower Left, Upper Right, Lower Right  indicano rispettivamente le coordinate 
dei quattro angoli estremi della mappa (ovvero del rettangolo in cui è inclusa la mappa)

• Center indica le coordinate del centro della mappa

• Minimum e Maximum indicano rispettivamente il valore minore e maggiore riportato nella 
mappa

• NoData Value indica quale valore è assegnato ai punti nulli (per le mappe della Regione 
Liguria e per buona parte delle altre cartografie istituzionali il valore è -9999)

4.2 Unire più mappe raster (attenzione ai valori nulli!)

Si possono unire più mappe raster in un unica mappa attraverso il comando 
raster=>miscellanea=>unione

“File di ingresso”: tramite il pulsante “Scegli” si selezionano i raster da unire tenendo premuto il 
tasto Ctrl. Si possono unire anche raster non caricati nel progetto. Nel caso si intenda unire tutti i 
file in una determinata cartella, si può selezionare la spunta “scegli la cartella in ingresso invece dei 
file” e in questo modo verranno uniti tutti i file della cartella scelta.

“File di uscita”: si salva in una cartella a scelta il file risultante dall'unione

“Valore Nulli”: spuntando questa casella si inserisce il valore assegnato ai punti nulli, nella maggior
parte dei casi  -9999. Nel caso non si spuntasse, viene assegnato di default il valore 0, che spesso 
però è fuorviante. Ad esempio, in caso di mappe di elevazione (DTM), assegnare ai punti nulli il 
valore 0 porta alla rappresentazione del mare come una continua pianura con quota = 0 m. Inoltre, 
attorno ad ogni squadro si trova una striscia di punti nulli, che venendo portati a 0  alterano la 
mappa unita risultante.

=> si clicca su “OK”
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ATTENZIONE: in alcune versioni di Windows avviando il comando si ottiene il messaggio di 
errore riportato sotto.

In realtà la mappa viene creata, ma non 
viene caricata nel progetto e il sistema di 
coordinate non è codificato 
correttamente. In questo caso è 
necessario importarla dalla cartella in cui
è stata salvata e accertarsi, eventualmente
risalvandola, che abbia il sistema di 
coordinate corretto. Accertarsi inoltre che
importando la mappa non sia cambiato il 
sistema di coordinate del progetto.

Eliminando la spunta alla voce “Valore Nulli” non compare nessun messaggio di errore, ma in motli
casi la mappa risultante presenta problemi sui valori riportati.
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Mappa con i valori nulli indicati correttamente (-9999) Mappa con i valori nulli lasciati =0 come di default

In alcuni casi, ad esempio lavorando con diversi fogli della CTR, non conviene unire le mappe 
raster perché si verrebbe a creare un layer troppo pesante e quindi poco gestibile. In questo caso 
conviene invece tenere le mappe separate e “accenderle” solo nel momento in cui servono.

4.3 Ritagliare una mappa raster

Le mappe raster spesso vengono fornite in “squadri” (ad esempio corrispondenti ai fogli in scala 
1:5000 della cartografia della Regione Liguria), che generalmente non coincidono con nessun tipo 
di confine generalmente utilizzato. Per evitare di avere mappe dall'apparenza “artificiale” e 
soprattutto di “portarsi dietro” dati inutili conviene ritagliare, come i vettori, anche le mappe raster 
sui confini dell'area di lavoro.

Menu Processing => Riga di comando

appare nella finestra principale un riquadro in cui si scrive clip

=> invio

Si apre un menu a tendina

=> selezionare la voce “Processing algorithm: Clip raster by mask layer”

=> invio
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Si apre la finestra “Ritaglia il raster con maschera” (Attenzione che contiene molte voci, quindi sul
lato destro ci potrebbe essere una barra di scorrimento)

Raster in ingresso => scegliere dal menu a tendina o dalla cartella (cliccando sul bottone con i tre 
puntini) il raster da ritagliare

Strato per la maschera => scegliere dal menu a tendina o dalla cartella (cliccando sul bottone con i 
tre puntini) la mappa vettoriale del contorno di ritaglio
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Valore Nullo: riportare il valore assegnato ai punti nulli

Spuntare la casella “Mantieni la risoluzione del raster in uscita”

nella casella “Ritagliato (da maschera)” indicare, cliccando il bottone con i tre puntini, percorso e 
nome della mappa risultante

=>  cliccare su Run

Il layer ritagliato verrà visualizzato sullo schermo e in legenda con il nome Ritagliato (da 
maschera)

Per alcuni formati di raster, in ambiente Windows, alla fine dell'elaborazione può comparire un 
messaggio in cui si avverte che il nuovo layer non ha un sistema di proiezione definito e che 
quindi gli verrà assegnato il sistema di default del software (di solito WGS84 con codice EPSG 
4326). In questo caso bisogna accertarsi che corrisponda con il sistema di riferimento del 
progetto e, nel caso fosse differente, risalvarlo nel sistema corretto.

La mappa ritagliata, comunque, viene salvata nella cartella che si è indicata come destinazione al 
momento di lanciare il comando di ritaglio, nel sistema di coordinate di default di QGIS. Al 
momento di importarla in un progetto bisogna quindi tenerne conto.

4.4 Analisi geomorfologica

Tra i Plugin preinstallati in QGIS si trova il plugin Analisi Geomorfologica (su sistemi operativi 
Linux e MacOS può essere chiamato anche Raster Terrain Analysis), che partendo da un modello 
digitale del terreno (DTM) permette di calcolare e visualizzare alcune importanti caratteristiche di 
un territorio.

Il plugin si trova nel menu a tendina “Raster”. Se non compare, è necessario attivarlo, una volta per
tutte.
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Menu Plugins => Gestisci e installa plugins => Installati => si spunta la casella “Plugin per 
l'analisi geomorfologica” => Close

Principali funzioni del plugin Analisi Geomorfologica

Menu Raster => Analisi Geomorfologica => Pendenza (Slope)
calcola la pendenza in gradi per ciascuna cella.

Raster altitudine => selezionare dal menu a tendina il DTM
Raster in uscita => salvare con nome il nuovo raster
Formato in uscita => formato della mappa che si va a creare. Di default viene indicato il formato 
GeoTIFF e conviene lasciarlo
=> OK

Ad ogni punto della mappa viene assegnato un valore che va da 0° per i punti in piano a 90° per i 
punti in verticale.
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Menu Raster => Analisi Geomorfologica => Esposizione...
calcola la pendenza in gradi per ciascuna cella.

Raster altitudine => selezionare dal menu a tendina il DTM
Raster in uscita => salvare con nome il nuovo raster
Formato in uscita => formato della mappa che si va a creare. Di default viene indicato il formato 
GeoTIFF e conviene lasciarlo
=> OK

Per ogni punto viene calcolato l'angolo in gradi rispetto alla direzione Nord, considerando Nord =0 
e ruotando per 360° in senso orario. In una mappa delle esposizioni possono trovarsi dei “buchi” 
ovvero delle aree in cui l'esposizione non può essere calcolata (evidenziati in rosso nella figura 
sopra). Si tratta delle aree pianeggianti, in cui i versanti non sono rivolti verso nessuna direzione.
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Menu Raster => Analisi Geomorfologica => Rilievo
Crea una visualizzazione tridimensionale di un territorio. Si tratta solo di una vista e non va 
utilizzata per elaborazioni successive.

Raster altitudine => selezionare dal menu a tendina il DTM
Raster in uscita => salvare con nome il nuovo raster
Formato in uscita => formato della mappa che si va a creare. 
=> OK

Ai punti nulli nel DTM di partenza viene assegnato il valore =0 e vengono riportati in nero.
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4.5 Colorare le cartine – assegnare uno stile alle mappe raster

Come per i vettori, anche per i raster è possibile modificare lo stile di rappresentazione attraverso la 
finestra Proprietà Layer (si seleziona il layer nella legenda => tasto destro Proprietà => Stile)

Inoltre, come nei vettori lo stile può essere salvato e caricato in un'altra mappa (tasto “stile” in 
fondo a sinistra)

4.5.1 Mappe in “bianco e nero”

Di default ogni layer raster viene visualizzato “in bianco e nero” cioè in una visualizzazione detta 
“banda singola grigia”, con riportati in colore più scuro i punti con valore più basso e più chiaro 
quelli con valore più alto (Gradiente colore da nero a bianco). Nelle caselle Min e Max, sono 
riportati rispettivamente il valori minimo e massimo associato ai punti presenti nel layer, 
eliminando però automaticamente i valori più estremi, ovvero il 2% più basso e più alto. 

Cliccando sul menu a tendina “Gradiente colore”, si può invertire la distribuzione dei colori 
assegnando ad un valore più alto un colore più scuro e ad un valore più basso un colore più chiaro.

Inoltre, spuntando l'opzione “Min/Max” e cliccando su “Carica” si considera tutto il range di valori
della mappa.

Per applicare le modifiche si clicca su “Apply” => “OK”
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Visualizzazione di default Visualizzazione dopo la trasformazione

4.5.2 Mappe a colori

Per realizzare mappe a colori esistono diversi tipi di visualizzazione, il più semplice è ilseguente:

dal menu a tendina “Tipo visualizzazione” scegliere la voce “banda singola falso colore”

nel riquadro “Carica i valori min/max” spuntare l'opzione “Min/max” => carica

nel riquadro “Genera nuova scala di colore” si sceglie un tipo di colori (ad esempio la scala da 
bianco a verde) => dal menu a tendina “modalità” si sceglie la voce “continuo” => si clicca sul 
pulsante “Classifica”

Il comando viene confermato cliccando sui pulsanti “Apply” e “OK”

In questo tipo di visualizzazione, i valori del raster vengono suddivisi in diverse classi secondo un 
algoritmo statistico e ad ogni classe è assegnato un colore nella scala scelta.

Si tratta in effetti di una visualizzazione molto "grezza", che può essere migliorata in diversi modi.
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4.5.3 Mappe con classi differenti

Nella visualizzazione “banda singola a falso colore”, nella colonna “Valore”, viene riportato il 
valore massimo incluso in ciascuna classe. Modificando quel valore, si modifica l'ampiezza della 
classe, cioè si possono includere in essa valori differenti.

Di default, nella prima classe, il valore massimo coincide con il valore minimo del raster. 
Nell'esempio esposto nelle figura sopra,vengono colorati di bianco solo i punti che hanno come 
valore -0.132. Cliccando due volte sul valore, questo può essere modificato. Se ad esempio 
desiderassi avere nella prima classe tutti i punti con quota inferiore a 50 m dovrei modificare il 
valore della prima classe e scrivere 50. Le classi possono avere ampiezza diversa, ad esempio potrei
avere nella prima classe tutti i valori inferiori a 50 m, mentre nella seconda tutti i valori inferiori a 
150 m. Di default mi viene assegnato un numero di classi dipendente dal range di valori del raster, 
ma può essere modificato elimnando o aggiungendo classi.

Selezionando una classe e cliccando sull'icona   la classe viene eliminata

Cliccando sull'icona   viene aggiunta una classe in fondo alla lista, con valore di default = 0, 

che quindi può essere modificata. 

Cliccando invece sull'icona   le classi vengono riordinate in modo da essere progressive. Ad 

esempio, non si può avere come valore massimo della prima classe 300 e come valore massimo 
della seconda 150, ma i valori massimi di ciascuna classe devono sempre essere progressivi. 

Cliccando su ciascun rettangolo colorato si può modificare il colore della classe corrispondente, non
è necessario infatti che i colori siano in scala.

Nella colonna “Etichette” viene riportata una didascalia per ciascuna classe indipendente dal 
valore massimo della classe corrispondente. Ad esempio, posso avere come valore massimo della
prima classe 50 e come etichetta “aree basse e esondabili”

Di default nel menu a tendina "Interpolazione colore" è selezionata la voce "Lineare". Questo significa 
che la colorazione di ciascun punto della mappa varia a seconda del valore, senza una divisione 
netta tra le classi.

Se si seleziona la voce "Discreta", tutti i punti appartenenti ad ogni classe avranno la stessa 
colorazione, generando quindi fasce ben definite.

Una volta che si è arrivati ad una suddivisione in classi soddisfacente, si conferma cliccando su 
“Apply” e “OK”.

ATTENZIONE!

In questo modo non si modificano i valori di un raster, ma solamente li si colora in maniera 
differente. Se si interroga un punto sulla mappa, il suo valore reterà lo stesso qualunque sia la 
sua colorazione.
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Colori ed etichette vengono riportati nella legenda della mappa.
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Un tipo comune di mappe con classi differenti sono le mappe della pendenza, in cui l'attenzione 
viene concentrata soprattutto su alcune classi, ad esempio in relazione al rischio potenziale di 
dissesti o per evidenziare eventuali problemi nell'accessibilità al territorio.

4.5.4 Mappe a classi uguali

In alcuni casi conviene visualizzare i valori di un raster secondo un certo numero di classi della 
stessa ampiezza. Questo può essere fatto modificando manualmente le classi presenti e imponendo 
che tutte abbiano la stessa ampiezza, oppure in modo (semi)automatico.

Dalla finestra Proprietà layer => stile

“Tipo visualizzazione” => “Banda singola falso colore”

Riquadro “Carica i valori min / max” => si spunta Min/max

Riquadro “Genera nuova scala di colore” => si sceglie la scala di colore => dal menu a tendina 
“Modalità” si sceglie la voce “Intervallo uguale” => si indica il numero delle classi +1 (ad 
esempio se desidero avere 10 classi di uguale ampiezza devo scrivere 11 nella finestra “Classi”). 
Questo perché la prima classe avrà sempre valore massimo pari al valore minimo del raster

=>  Si scrive nelle caselle Min e Max rispettivamente i valori minimi e massimi del raster. In alcuni 
casi conviene approssimare questi valori, per evitare di avere classi di un ampiezza poco 
significativa (ad esempio, una mappa divisa in 10 classi ciascuna con valori massimi multipli di 
114.4444 non è molto comprensibile). Nel caso riportato in figura, ad esempio, i valori minimo e 
massimo corrispondono rispettivamente a -0,132 e 1030. Per visualizzare classi da 100 m. 
approssimo i valori minimo e massimo rispettivamente a 0 e 1100 e impongo di dividere i valori in 
12 classi. In questo modo mi crea una prima classe che comprende solo il valore 0 e 11 classi da 
100 m. L'ultima classe, in particolare, conterrà i valori tra 1000 oltre la quota 1000.

=> Classifica

=> Si elimina la prima classe, ovvero quella che contiene solo il valore minimo

=> Si conferma cliccando “Apply” e “OK”
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Un caso particolare di mappa divisa in classi uguali è la mappa dell'esposizione dei versanti. 
Quando viene creata attraverso il plugin di Analisi geomorfologica, per ogni punto viene indicato 
l'angolo che questo forma con la direzione Nord, ruotando in senso orario. In questa forma la mappa
può essere poco leggibile perché non è immediato collegare un angolo con il punto cardinale più 
vicino ad esso. Spesso quindi l'orientamento dei versanti viene raggruppato secondo quattro o otto 
settori (rispettivamente Nord, Est, Sud, Ovest oppure Nord, Nord-Est, Est, Sud-Est, Sud, Sud-
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Ovest, Ovest, Nord-Ovest).  

Impostando come valori minimo e massimo rispettivamente 0 e 360, imponendo cinque classi, una 
volta eliminata la prima che contiene solo il valore 0, le altre contengono i valori da 0° a 90°, da 90°
a 180°, da 180° a 270° e da 270° a 360°. Però, anche in questo caso non è così semplice collegare i 
valori degli angoli ad un punto cardinale. Un punto nel settore 0° - 90°, infatti, a seconda del valore 
può essere orientato a Nord (ad esempio se ha come valore 3°) o a Est (se ha come valore 85°). 

Conviene quindi “ruotare” i valori di 45° in senso orario, impostando quattro classi, ma con valore 
minimo 45 e valore massimo 315. In questo caso la classe 1 (Nord) conterrà i punti con valore da 0
a 45°, mentre le classi successive comprenderanno i punti che si trovano in un range di 45° in meno 
e in più dei punti Est, Sud e Ovest. Rimane un buco, di 45° ovvero la classe dei punti con valore 
compreso tra 315° e 360°. Si crea quindi un'altra classe, impostando come valore massimo 360 e 
assegnando il colore della prima classe e l'etichetta Nord.
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Analogo ragionamento può essere fatto se si intende visualizzare l'orientamento dei versanti 
secondo otto settori. In questo caso va impostato come valore minimo 22,5 e come valore massimo 
337,5.

4.5.5 Rendere uno o più colori trasparenti

La gestione della trasparenza nelle mappe raster permette, sia  di modificare la trasparenza 
dell'intera mappa, sia di modificare la trasparenza dei singoli valori o classi di valori. Ad esempio 
questa funzione è particolarmente utile per rendere trasparente lo sfondo di una CTR.

Per modificare la trasparenza dell'intera mappa:

si seleziona il layer => tasto destro => “Proprietà” => “Trasparenza” => “Trasparenza globale” 
=> si assegna il valore di trasparenza desiderato

Per modificare la trasparenza di un singolo valore o di una classe di valori:

si seleziona il layer => tasto destro => “Proprietà” => “Trasparenza” 

=> Si clicca sull'icona 

=> Nelle colonne Da e A si scrivono i valori che si intende rendere trasparenti (ad esempio Da 50 A 
100, oppure Da 0 A 0, ecc..). Cliccando sull'icona  si può scegliere direttamente dalla mappa un 
punto il cui valore si vuole rendere trasparente.

=> Si conferma con “Apply” e “OK”

Da questa finestra è inoltre possibile mandare a nullo alcune valori della mappa (il caso più comune
è che si siano importati dei punti con valore = 0 e li si voglia rendere nulli)
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4.6 Compito a casa

• Caricare tutti i DTM del bacino del Bisagno, unirli e ritagliarli sul contorno del bacino, 
facendo attenzione alle coordinate, al momento del ritaglio. Attenzione che a volte, senza 
apparente motivo i layer vengono trasformati in un sistema a caso, quindi è necessario 
controllare spesso e risalvare in Monte Mario (3003) qualsiasi cosa si fosse modificata.

• Partendo ogni volta dal DTM ritagliato sul Bisagno fare le mappe della pendenza, 
dell'esposizione e del rilievo

• Colorare secondo clasii significative le mappe raster dell'altimetria e della pendenza

• Visualizzare la mappa delle esposizioni secondo 8 classi
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5 Alcuni plugin utili
Obiettivo:

• Conoscere come si possono espandere le funzionalità di QGIS tramite l'utilizzo di plugin

• Conoscere l'utilizzo di alcuni plugin

La versione di QGIS come viene scaricata, è solamente il “nucleo” di questo software. Permette 
infatti di svolgere le elaborazioni più comuni, ma non è particolarmente specializzato in nessun 
campo. Per elaborazioni complesse e specifiche, è necessario installare altri componenti, detti 
plugin, che integrano il software principale ed aggiungono diverse funzionalità.

Diversamente dai “pacchetti” forniti da alcune case produttrici di software commerciali, completi 
ma estremamente pesanti e complicati da utilizzare, questo tipo di struttura fa si che il software sia 
particolarmente “leggero” e veloce e contemporaneamente dà la possibilità ad un utente generico, di
installare solo le funzionalità di cui ha effettivamente bisogno e ad un utente più avanzato (che 
abbia cioè una certa base di programmazione) di creare strumenti adatti alle proprie necessità, di 
integrarli nella parte generale e di condividerli. 

Esistono diverse centinaia di plugin, alcuni validati, altri ancora sperimentali, altri infine superati o 
inclusi nella struttura principale di QGIS. In questa sede si vedrà come accedere al repertorio dei 
plugin e come scegliere e installare le funzionalità desiderate. Inoltre si approfondiranno alcuni 
plugin di utilità generale. 

In QGIS non è possibile “cliccare tutte le icone per vedere se c'è qualcosa che mi serve”, ma 
bisogna partire da un ragionamento diametralmente opposto. Quale problema devo risolvere? Lo 
posso semplificare?  È un problema di geometria o di dati? …. Una volta che ho scomposto il 
problema nelle sue parti più semplici posso cercare se esiste uno strumento in grado di effettuare 
elaborazioni che mi avvicinino o mi portino alla sua soluzione.

Siccome chiunque può contribuire, purché fornisca software open e funzionante, è più facile che la 
stessa funzione sia svolta da più plugin, piuttosto che nessuno abbia trovato un modo di affrontare 
un determinato problema. In questo caso può essere necessario sperimentare le diverse soluzioni per
individuare quella più adatta alle circostanze, ma è anche importante il contributo in termini di 
consigli ed esperienze offerto dalla comunità.

5.1 La gestione dei plugin

Alcuni plugin sono già installati nel software principale, ed è sufficiente attivarli, mentre altri si 
trovano in un “repository” (cioè una sorta di contenitore) accessibile tramite la rete ed è necessario 
installarli. Per visualizzare i plugin disponibili, verificare quali sono installati o cercare e installarne 
altri:

Menu “plugins” => “Gestisci e installa plugins”
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Perché la funzione “Gestisci e installa plugins” funzioni correttamente è necessario che il 
computer sia connesso ad una rete. In caso contrario sarà possibile solo accedere ai plugin già 
installati nel sistema ed eventualmente attivarli o disinstallarli. 

La scheda “Tutto”  mostra la lista di tutti i plugin disponibili per QGIS. Cliccando sul nome di ogni
plugin compare nella parte destra della finestra una breve spiegazione in inglese delle funzioni del 
plugin con i riferimenti di chi l'ha sviluppato. Quelli contrassegnati con un quadratino sono già 
installati e per attivarli è necessario spuntarli. 

• Per installare un plugin =>  selezionarlo nella lista => pulsante “Installa plugin”

• Per disinstallare un plugin già installato =>  selezionarlo nella lista => pulsante “Disinstalla
plugin”

• Per aggiornare all'ultima versione disponibile un plugin già installato =>  selezionarlo nella 
lista => pulsante “Aggiorna tutto”

• In alcun casi, ad esempio se è stato installato sul computer nuovo software (Open o 
commerciale), o se sono stati effettuati aggiornamenti al Sistema Operativo, può capitare 
che un plugin non funzioni più correttamente. In questo caso può essere utile reinstallarlo =>
selezionarlo nella lista => pulsante “Reinstalla plugin”

La casella “Cerca” funge da filtro. Per trovare un particolare plugin è sufficiente scrivere le prime 
lettere del nome del plugin (se si conosce) o la funzione che questo dovrebbe svolgere. Se uno o più
plugin rispondono alle condizioni richieste vengono visualizzati in una lista. Il filtro funziona sul 
nome del plugin e sulla descrizione. 
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La scheda "Installati" mostra la lista dei plugin installati, siano attivati o meno

La scheda "Non installati" mostra la lista dei plugin non installati

La scheda "Aggiornabile" mostra i plugin non ancora aggiornati all'ultima versione. I plugin 
aggiornabili nella lista generale, comunque, appaiono scritti un grassetto ecompare un messaggio di 
avviso nella parte dedicata alla descrizione.

La scheda "Impostazioni"permette di scegliere quali plugin visualizzare nella lista generale. Di 
default vengono visualizzati solo i plugin testati ed in uso, ma per utilizzi particolari potrebbe essere
necessario utilizzare plugin sperimentali, quindi potenzialmente "instabili" o plugin obsoleti, cioè 
superati o legati versioni vecchie di QGIS. E' possibile inoltre, attraverso un URL, collegarsi ad altri
repository diversi da quello ufficiale,.

Una volta installati e attivati, i plugin compaiono come icone nella barra degli strumenti o come 
voci nel menu “Plugins” o nei menu relativi al tema cui si riferiscono. Ad esempio, il plugin per la 
georeferenziazione dei raster comparirà nel menu “Raster”.

5.2 Alcuni esempi di plugin

Di seguito vengono presentati alcuni plugin di utilizzo comune e di uso piuttosto semplice.

5.2.1 Table manager (da installare)

Il plugin “Table manager” (menu “Vettore” => “Table manager”) permette di modificare una 
tabella associata ad un vettore selezionato, utilizzando le seguenti operazioni:

• Aggiungere campi (colonne) specificando il tipo di dati e la lunghezza di ciascun campo

• Rinominare campi (Attenzione! Il nome di ciascun campo non deve superare i 10 caratteri)

• Duplicare campi 

• Cambiare l'ordine dei campi
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• Eliminare campi

Una volta effettuate le modifiche si attiveranno i pulsanti “Save” per modificare la tabella 
originale” e “Save as”  per creare un nuovo shape con la tabella associata modificata.

5.2.2 Openlayers Plugin (installato, da attivare)

Il plugin OpenLayers Plugin (menu “Web”=>”OpenLayers Plugin”) permette di visualizzare come
sfondo di un progetto QGIS le mappe fornite da diversi fornitori di servizi, open e commerciali.

ATTENZIONE! Quando si utilizza questo plugin è necessario essere connessi in rete, dato che 
le mappe di sfondo vengono richiamate via web.

Si visualizza sullo schermo il progetto alla scala desiderata. Non conviene utilizzare il plugin in un 
progetto vuoto perché in questo caso verrebbe inserito come sfondo un planisfero, con tempi di 
visualizzazione molto lunghi e la possibilità di bloccare il programma.  

Web => OpenLayers Plugin => si sceglie la mappa che si vuole impostare come sfondo

L'efficienza di questo plugin dipende naturalmente dalla velocità della connessione internet. In 
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particolare, nel caso di operazioni di zoom o di spostamento della mappa, il referesh del progetto 
può essere anche piuttosto lento.

ATTENZIONE!! Quando si utilizza l'OpenLayers Plugin, il sistema di coordinate del progetto
viene automaticamente impostato sul sistema di coordinate “WGS84 / Pseudo Mercator”, con 
codice EPSG 3857. Tutti i layer vengono comunque visualizzati nella corretta posizione, ma nel 
caso si crei un layer nuovo (ad esempio ricalcando elementi dalle foto satellitari di sfondo), è 
necessario reimpostare il sistema di coordinate del progetto e accertarsi di salvare il nuovo layer nel 
sistema di coordinate corretto. In caso contrario non saranno possibili operazioni tra il nuovo layer e
quelli già esistenti.

5.2.3 Georeferenziatore (installato, da attivare)

Il plugin Georeferenziatore (menu Raster => Georeferenziatore) permette di georeferenziare, 
ovvero posizionare mappe raster nella posizione corretta dello spazio, in sistemi di coordinate 
geografiche o proiettate. L’approccio di base del plugin è determinare, tramite il confronto con una 
mappa georeferenziata, le coordinate di alcuni punti del raster da georeferenziare. Sulla base di 
queste informazioni, vengono applicati diversi algoritmi e la mappa viene traslata, ruotata ed 
eventualmente deformata per far coincidere i punti individuati con le corrispondenti coordinate 
assegnate. A seconda degli algoritmi che si sceglie di utilizzare il numero di punti noti (punti di 
controllo) necessari è variabile: si va da un minimo di tre punti nel caso si effettui una semplice 
traslazione/rotazione ad un minimo di 9 per trasformazioni più complesse. Aumentando i punti di 
controllo la precisione tende inizialmente a migliorare, per poi diminuire nuovamente superato un 
certo numero.

Principali comandi del plugin di georeferenziazione
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Carica un raster Sposta la vista

Aggiunge un nuovo punto Ingrandisce la vista

Sposta un punto GCP Rimpicciolisce la vista

Elimina un punto Zoom sul layer 

Sposta un punto GCP Zoom precedente

Carica punti GCP Zoom successivo

Salva punti GCP come Genera uno script GDAL 

Impostazioni di trasformazione

Avvia georeferenziazione

Prima di iniziare un processo di georeferenziazione è necessario avere aperta in QGIS una 
mappa georeferenziata di scala nominale analoga a quella da georeferenziare. (non ha senso 
tentare di georeferenziare una mappa in scala 1:1000 confrontandola con una CTR in scala 
1:25.000)

Menu Raster => Georeferenziatore  => si apre la finestra “Georeferenziatore”
Si importa nel Georeferenziatore il raster da georeferenziare menu “File” => “Apri raster”  o 

=> menu “Preferenze” => “impostazioni di trasformazione” oppure 
=> si apre la finestra “impostazioni di trasformazione”

=> dal menu a tendina “Transformation 
Type” scegliere il tipo di trasformazione che 
si intende utilizzare.  I tipi più comuni sono 
“Lineare”, che prevede solo una traslazione e
rotazione della mappa, indicato soprattutto 
per la georeferenziazione di mappe già redatte
in un sistema proiettato e   “Polinomiale 1” e 
“Polinomiale 2”, che invece prevedono 
alcune deformazioni, più adatti in caso di 
mappe redatte “a occhio”, in sistemi di 
coordinate relative” (ad esempio un disegno a 
CAD) o in sistemi di coordinate particolari 
(catastali, alcuni tipi di rilievi topografici, 
carte storiche, fotografie aeree, ecc.)
=> dal menu a tendina “SR di destinazione” 
scegliere il sistema di coordinate in cui si 
vuole georeferenziare la mappa
=> nella casella “Raster in uscita” indicare il 
nome e il percorso con cui verrà salvata la 
mappa georeferenziata.  Di default la mappa 
viene salvata in formato geotiff e conviene 
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lasciarla così.
=> accertarsi che la casella “Carica in QGIS una volta eseguito” sia spuntata.
=> Cliccare sul pulsante “OK”. A questo punto sono state definite le modalità di trasformazione e si
iniziano a selezionare i punti di controllo.

=> si individua aiutandosi con le funzioni di zoom e spostamento mappa nel georeferenziatore un 
punto di cui si conoscono le coordinate o che si è in grado di ritrovare su una mappa georeferenziata
aperta in QGIS. 

=>  menu “Modifica” => “Aggiunge un nuovo punto”  oppure     e si clicca sul punto 
individuato 

=> si apre la finestra “Inserisci le coordinate mappa”. Se si conoscono le coordinate del punto 
selezionato (ad esempio nel caso si prendano come punti di controllo gli angoli di una vecchia 
CTR) si scrivono direttamente negli spazi, altrimenti si clicca il pulsante “Dalla mappa”
=> si viene riportati alla finestra principale di QGIS, e il cursore apparea a forma di croce (la 
finestra del georeferenziatore viene ridotta e spostata in basso a sinistra) 

=> cliccare sul punto corrispondente a quello selezionato nel georeferenziatore. ATTENZIONE! Se
si usano le funzioni di zoom e sposta mappa per individuare il punto da cliccare, si esce dal 
georeferenziatore ed è necessario ingrandire la finestra e cliccare nuovamente sul pulsante 
“Dalla mappa”

=> si viene riportati nuovamente al georeferenziatore. Nella finestra “Inserisci le coordinate 
mappa”  gli spazi destinati alle coordinate appaiono compilati => si clicca sul pulsante “Ok” => 
nel punto selezionato appare un pallino rosso e nella parte bassa della finestra una linea di tabella in 
cui sono riportate le coordinate del punto nel georeferenziatore e nel sistema di riferimento del 
progetto QGIS.
=> si ripete l'operazione per più punti, possibilmente distribuiti uniformemente su tutta la mappa.
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=> quando è stato individuato almeno il numero minimo di punti richiesto per la trasformazione 
menu “File” => “Avvia georeferenziatore”  oppure 

 La mappa viene caricata nel progetto QGIS e minimizzando il Georeferenziatore la si può 
visualizzare (per verificarne l'accuratezza può essere utile renderla parzialmente trasparente).  Se il 
risultato è soddisfacente si può chiudere il georeferenziatore, altrimenti si possono scegliere altri 
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punti o modificare quelli già individuati. ATTENZIONE! Conviene sempre salvare i punti di 
controllo, sia per tenere traccia della trasformazione eseguita, sia per eventuali correzioni future.
Menu “File” => “Salva punti GCP come...” oppure  e si salva un file contenete le impostazioni
della trasformazione e i punti di controllo.
Per elaborazioni successive questi possono quindi essere caricati nel georeferenziatore 

 Menu “File” => “Carica punti GCP” oppure  

5.2.4 Plugin di interrogazione spaziale (installato, da attivare)

Il plugin “Interrogazione spaziale” (menu “Vettore” => “Interrogazione spaziale”) permette di 
selezionare elementi in un layer (sorgente degli oggetti) facendo riferimento alla loro posizione 
rispetto agli  elementi di un altro layer (riferimento). 

Gli operatori spaziali sono:
Contenuto => sono selezionati gli oggetti del layer sorgente che sono completamente contenuti in 
uno o più oggetti del layer di riferimento
Contiene (solo poligoni) => sono selezionati gli oggetti del layer sorgente che contengono uno o 
più oggetti del layer di riferimento
Interseca =>  sono selezionati gli oggetti del layer sorgente che sono contenuti del tutto o in parte 
in oggetti del layer di riferimento
Sovrappone (solo poligoni) =>  sono selezionati gli oggetti del layer sorgente che toccano i 
confini di uno o più oggetti del layer di riferimento
Tocca =>  sono selezionati gli oggetti del layer sorgente che hanno confini in comune con il layer 
di riferimento
E’ disgiunto => sono selezionati gli oggetti del layer sorgente che non toccano in nessun punto gli
oggetto del layer di riferimento
E’ uguale a (solo poligoni)=>  sono selezionati gli oggetti del layer sorgente che coincidono con 
oggetti del layer di riferimento
Attraversa (solo linee e punti) => sono selezionati gli oggetti del layer sorgente che toccano i 
confini di uno o più oggetti del layer di riferimento
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Selezionare il layer sorgente dal menu a tendina “Seleziona la sorgente degli oggetti da”
=> Selezionare l'operatore spaziale dal menu a tendina “Dove l'oggetto”
=> Selezionare il layer di riferimento dal menu a tendina “Riferimento oggetti di”
=> Click su “Apply”

Di default viene creata una selezione contenente solo gli gli oggetti che corrispondono alla 
condizione scelta. Se nel progetto sono già selezionati altri oggetti si può scegliere dal menu a 
tendina “E usa il risultato per” se aggiungerli a quelli già selezionati o sottrarli da quelli.
Questa possibilità si utilizza soprattutto quando si devono concatenare più condizioni (ad esempio, 
tutti gli oggetti che hanno un confine coincidente con il bacino del Bisagno e che non sono 
compresi nel comune di Genova)

Si apre una finestra contenente sulla destra la lista degli oggetti selezionati che rispondono alla 
condizione imposta.

Questa lista può essere salvata come nuovo vettore cliccando il pulsante 
Si può inoltre selezionare un singolo elemento della lista e individuarlo spuntando la casella “Zoom

all'oggetto” oppure salvarlo come vettore cliccando il pulsante 

Per trasformare il layer creato in uno shape, va quindi salvato con nome.

5.2.5 Geometry Checker (installato, da attivare dalla versione 2.12 in 
poi) 

Può capitare che le geometrie di una mappa vettoriale non siano corrette, per errori nella 
digitalizzazione dei dati, ripetuti passaggi di conversione in formati compatibili solo parzialmente 
(es. da dxf a shp), modifiche poco accurate, ecc.. La presenza di tali errori detti “errori topologici”, 
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anche se toricamente poco rilevanti rispetto a tutta la mappa,  può portare tuttavia al cattivo 
funzionamento del software e alla perdita di dati. Un esempio comune è dato dall'unione di due 
mappe di poligoni: se almeno una riporta errori topologici, nella mappa risultante possono apparire 
“buchi” bianche in corrispondenza dei poligoni contenenti errori.

I principali errori topologici sono:

• geometrie duplicate

• geometrie sovrapposte

• poligoni non chiusi

• “caramelle”, ovvero incroci all'interno dello stesso oggetto

• punti duplicati in una linea o nel contorno di un poligono.

Il plugin Geometry Checker (menu “Vettore” => “Strumenti di geometria => Check Gometries”) 
permette di individuare gli errori topolgici in un layer e di correggerli in maniera automatica. 
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Dal menu a tendina “vettore in ingresso” selezionare il vettore da correggere

=> spuntare le caselle relative agli errori da correggere (“Geometry validity”)

=>  spuntare le caselle relative ai tipi di geometria ammessi nel layer (“Allowed geometry types”). 
QGIS in ogni layer accetta solo un tipo di geometria (punti/multipunti, linee/multilinee e poligoni/ 
multipoligoni), altri software accettano più tipi di geometrie nello stesso layer, altri (ad esempio i 
software di supporto alla maggior parte dei dispositivi GPS) non accettano multipunti, multilinee e 
multipoligoni

=> spuntare le caselle relative ai valori minimi della geometria e assegnare delle soglie (“Geometry
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conditions”). Aree o segmenti “troppo piccoli” o angoli prossimi allo zero molto spesso sono il 
risultato di errori nella digitalizzazione o di conversioni tra raster e vettore o tra formati diversi o di 
incorci di mappe poco precise.

=> spuntare le azioni che si desidera far compiere al pulgin per correggere il layer (“Topology 
checks”)

=> indicare se le correzioni devono essere applicate al layer selezionato o se si desidera farne una 
copia. (opzione preferibile)

=> Click su “Esegui”  => viene visualizzata la scheda “Risultato”

In questa viene riportata la lista degli oggetti contenenti errori e per ciascuno il tipo di errore. 
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=> selezionare gli errori che si desidera correggere (di solito tutti, se sono tanti si può procedere in 
più volte)

=> Scegliendo l'opzione “Fix selected errors using default resolution” tutti gli errori vengono 
corretti automaticamente, oppure

=> scegliendo l'opzione “Fix selected errors, prompt for resolution methods” viene chiesto per 
ciascuno se e come deve essere corretto.

Siccome alcune errori possono derivare dal concatenarsi di oggetti topologicamente errati, può 
succedere che sia necessario ripetere il procedimento, o viceversa, che eliminando l'errore 
“sorgente” si risolvano automaticamente anche gli altri.

5.3 Compiti a casa

• Mettere come sfondo un visualizzatore di mappe a scelta (Google Earth, Bing, ecc.)

• Utilizzarlo come riferimento per georeferenziare la tavoletta IGM in scala 1:25.000 relativa 
alla zona di Sant'Olcese

• Selezionare i corsi d'acqua completamente inclusi nella Val Bisagno 

• Selezionare le frane della Val Bisagno che in qualche modo intersecano un corso d'acqua e 
salvarle come nuovo layer

• Accertarsi che tutte le geometrie dell'uso del suolo della Val Bisagno siano corrette e 
intersecarle con le aree in frana.

• Sistemare la tabella delle aree risultanti, lasciando solo i dati significativi e assegnando alle 
colonne nomi comprensibili
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6 Modificare una mappa vettoriale
Obiettivo: 

• Aggiungere o eliminare elementi da una mappa
• Creare mappe “ex novo”
• Disegnare in QGIS
• “Pulire” le mappe eliminando errori topologici o elementi inutili
• Lavorare sulle tabelle eliminando i dati associati inutili o incomprensibili e aggiungendo in 

automatico dati relativi a tutto il layer

Finora si è lavorato su dati già preparati da altri e ogni elaborazione fatta ha portato alla creazione di
una nuova mappa. In questo capitolo invece si vedrà come realizzare partendo da zero nuove mappe
e come modificare quelle su cui si sta lavorando, in termini di geometria e di dati associati.
Buona parte delle mappe vengono create come sottoinsiemi o unioni di mappe preesistenti, ma può 
ad esempio capitare di dover vettorializzare, ricalcandoli, alcuni elementi di una foto, o di una 
vecchia mappa, o di rappresentare “a mano libera” le aree su cui prevedere interventi generali, 
l'ingombro di una discarica o di un cantiere, il tracciato di un nuovo sentiero, una serie di punti in 
cui effettuare rilievi, ecc.
Certamente QGIS non offre la varietà di strumenti di disegno e grafica offerti da un software 
dedicato, ad esempio AutoCAD, ma fornisce il necessario per disegnare mappe funzionali. Più che 
presentare una mappa “bella”, in un GIS è infatti importante visualizzare chiaramente delle 
informazioni e offrire la possibilità di metterle in relazione fra di loro e con dati provenienti 
dall'esterno, di eseguire ricerche nei dati, di aggiornarle con il minimo sforzo possibile. Non è tanto 
importante il colore con cui sono indicate le aree in frana, ma piuttosto lo è considerare la distanza
tra queste e i centri abitati, la loro estensione rispetto alla superficie totale del territorio, il fatto 
che i versanti siano o mento tagliati da strade, ecc.
Per rappresentare ed interpretare correttamente i rapporti tra i diversi elementi che caratterizzano un
territorio è molto importante garantire la correttezza delle mappe con cui si lavora, sia che siano 
realizzate ex novo, sia che si stia lavorando su dati istituzionali o comunque raccolti da altri. Errori 
topologici, ovvero relativi alla geometria delle mappe e alle relazioni tra i diversi elementi rendono 
impossibili molte elaborazioni o ne falsano i risultati, così come attributi non corretti o non 
aggiornati. Per calcolare la via più veloce per arrivare con un mezzo di soccorso in un determinato 
punto, tutti i tratti stradali devono congiungersi correttamente, non avere buchi e parti raddoppiate
o incrociate Lunghezze o informazioni relative alla percorribilità devono essere corrette e 
aggiornate.
Dopo avere trovato, caricato e preparato nelle parti precedenti le mappe che ci servono, adesso si 
tratta di garantirne, per quanto possibile l'accuratezza, e la rispondenza con le nostre necessità. In 
parallelo si inizierà a produrne di nuovi, specificamente finalizzati al progetto. 
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6.1 Creare un nuovo layer vettoriale

Se si devono creare nuove mappe vettoriali QGIS offre diverse possibilità:
• shapefile, cioè mappe singole, ogni mappa è indipendente dalle altre
• vettori spatialite, cioè tabelle di un database in cui ad ogni record è associata una geometria. 

Ogni mappa quindi può essere associata ad altre.
• mappe gpx, cioè nel formato di interscambio comunemente utilizzabile dalla maggior parte 

dei dispositivi GPS.
Dalla versione 2.8 è inoltre possibile creare delle mappe di lavoro temporanee, che si cancellano 
automaticamente alla chiusura del progetto. 
E' importante ricordare che una mappa in formato shapefile o spatialite può contenere solo un tipo 
di geometria, cioè punti, linee o poligoni. Una mappa in formato gpx può invece contenere punti e 
linee.
In questa sede si spiegherà come creare un nuovo shapefile.
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E' necessario per prima cosa indicare che tipo di geometrie dovrà contenere la nuova mappa 
vettoriale, se punti, linee o poligoni (A). Successivamente si deve specificare il sistema di 
coordinate in cui verrà creata la nuova mappa (B). QGIS sceglie automaticamente quello in cui è 
impostato il progetto, ma a volte potrebbe essere necessario creare un vettore in un sistema 
differente. Di default, creando un nuovo vettore viene assegnato un campo ID, di numeri interi (C), 
ma è possibile aggiungere nuovi campi specificando il tipo di dati (testo, numeri interi, numeri 
decimali o data), la lunghezza del campo, ovvero quanti caratteri può contenere e nel caso di numeri
decimali, la precisione cioè quanti decimali devono essere scritti dopo la virgola
Una volta definite le caratteristiche dei campi si conferma cliccando sul pulsante "Aggiungi alla 
lista degli attributi" (D).

I nomi dei campi (cioè l'intestazione delle colonne 
della tabella) devono contenere al massimo 10 
caratteri che comprendono lettere maiuscole o 
minuscole o numeri, ma senza spazi e senza 
caratteri speciali o lettere accentate.
Una volta confermato cliccando su OK, il nuovo 
vettore è creato, compare in legenda ma è vuoto.
Se si apre la tabella si vedranno le intestazioni di 
colonna ma senza alcuna riga. Man mano che si 
aggiungeranno elementi sulla mappa verranno 
automaticamente aggiunte le corrispondenti righe in 
tabella.

6.2 Aggiungere nuovi oggetti sulla mappa

Di default, un layer appena creato è vuoto e in modalità "sola lettura". Per aggiungere elementi è 
necessario quindi, per prima cosa attivarlo, cioè renderlo modificabile. 
1. Selezionare il layer da modificare
2. renderlo modificabile cliccando sulla "matita"
Nelle mappe in modalità modificabile i vertici di linee e poligoni vengono visualizzati come 
crocette e i campi della tabella allegata diventano scrivibili. Quando una mappa è in modalità 
modificabile lo è automaticamente anche la tabella associata e viceversa
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Una volta attivato il layer è possibile aggiungere oggetti come illustrato sotto.

Selezionare lo strumento Aggiungi elemento Disegnare un nuovo elemento e confermare cliccando
con il tasto destro del mouse
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Aggiungere nel modulo i dati associati e confermare con 
OK

La tabella viene automaticamente aggiornata

Quando sono stati aggiunti gli elementi desiderati si salva il layer cliccando sull'icona   

Lo si rimette quindi in sola lettura cliccando sull'icona  

Nel caso si debbano disegnare oggetti adiacenti è fondamentale evitare sovrapposizioni e incroci 
delle geometrie e piccoli spazi tra una e l'altra. A questo proposito è necessario impostare 
correttamente le opzioni di snap, cioè impostare una tolleranza, attorno ai vertici e ai lati di una 
geometria, in modo che un punto inserito entro quel limite venga automaticamente portato a 
coincidere con l'oggetto esistente.
Menu “Impostazioni” => “Opzioni di snap...”
=> Dal menu a tendina “Modalità di snapping” scegliere a quali layer si desidera applicare gli 
snap. In particolare, se si seleziona “Layer in uso” solo i punti del layer selezionato saranno 
“calamitati”, se si seleziona “Tutti i layer”, lo saranno tutti, se si seleziona “Avanzate” è possibile 
scegliere quali lo debbano essere.
=> dal menu a tendina “Snap a” si seleziona il tipo di oggetti che dovranno essere “calamitati”
=> nella casella “Tolleranza” si inserisce la distanza entro la quale è attiva la funzione di snap. 
Questa varia a seconda della scala in cui si intende lavorare, conviene comunque lasciarla impostata
in “unità di mappa” ed effettuare diversi trentativi.

6.3 Cancellare oggetti dalla mappa o dalla tabella

Per cancellare oggetti dalla mappa.
Dopo aver messo il layer in modalità modificabile:
1. Selezionare con lo strumento di selezione che si ritiene più appropriato gli oggetti da cancellare
2. Eliminarli cliccando sull'icona "Elimina il selezionato"
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Per cancellare oggetti dalla tabella
Dopo aver messo il layer in modalità modificabile:
1. Selezionare le linee di tabella corrispondenti agli oggetti da eliminare
2. Eliminarli cliccando sull'icona "Elimina il selezionato"
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6.4 Modificare la tabella

Una volta messa la tabella in modalità modificabile è sufficiente cliccare due volte sulla cella da 
modificare e riscriverne il contenuto.

6.4.1 Aggiungere colonne a una tabella

Mettere la tabella in modalità modificabile

=> Click sull'icona “Nuova colonna” => si apre la finestra “Aggiungi colonna”

=> Inserire nella casella nome il nome della colonna. ATTENZIONE!!! al massimo 10 caratteri, 
senza spazi e caratteri speciali
=> Scegliere dal menu a tendina “Tipo” il tipo di dati che saranno contenuti nella colonna. QGIS 
accetta solo quattro tipi di dati (Testo, Numeri interi, Numeri decimali e Data)
=> Inserire nella casella “Lunghezza” il numero massimo dei caratteri che può contenere il campo. 
(nel caso di numeri decimali viene chiesta anche la precisione, cioè quanti decimali devono essere 
aggiunti dopo la virgola)
ATTENZIONE! Una volta scelto il tipo di dati e la lunghezza del campo non si può cambiare
=> Click su “OK”
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6.4.2 Eliminare colonne da una tabella

Mettere la tabella in modalità modificabile

=> Click sull'icona “Elimina colonna” => si apre la finestra “Rimuovi attributi ”
=> Selezionare i nomi delle colonne che si desidera eliminare
=> Click su “Ok”

6.4.3 Collega tabella (join)

Tramite l'operazione di Join è possibile collegare un foglio di calcolo (ad esempio una tabella 
Excel) ad un vettore caricato nel progetto QGIS, purché abbiano una colonna in comune, cioè che 
contenga gli stessi dati.

Trascinare nel progetto QGIS la tabella che si desidera collegare ad un vettore. L'icona della tabella 
comparirà nella legenda
=> Selezionare il vettore cui si desidera unire la tabella
=> Click con il tasto destro => “Proprietà” => “Join”
=> Click sull'icona    Si apre la finestra “Aggiungi vettore da unire (Join)”

Dal menu a tendina “Vettore di join” selezionare la tabella
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=> Dal menu a tendina “Campo di unione”  selezionare il campo della tabella in comune con il 
vettore
=> Dal menu a tendina “Campo destinazione” selezionare il campo di attributi del vettore in 
comune con la tabella che si desidera unire
=> spuntando la casella “seleziona campi per l'unione” è possibile scegliere quali campi della 
tabella si intende unire al vettore
I campi uniti al vettore dalla tabella avranno un prefisso prima del nome. Spuntando la casella 
“Prefisso del nome del campo personalizzato” è possibile indicare un prefisso
=> Click su “Ok”
=> Click su “Apply” e “Ok” nella finestra “Proprietà vettore”

La tabella associata al vettore avrà in fondo i campi presi dalla tabella “esterna” e contrassegnati dal
prefisso scelto. Per rendere il join permanente è necessario salvare il layer modificato come 
nuovo shape.

6.5 Modificare dalla mappa i dati associati a ciascun oggetto 

Dopo aver messo la mappa in modalità modificabile
Con lo strumento "Informazioni elementi" (1)  cliccare sull'oggetto di cui si vogliono modificare i 
dati (2). Fare doppio click sul dato da modificare nel "Form di modifica geometria", effettuare i 
cambiamenti (3) e  alla fine confermare cliccando su OK (4).
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 Se cliccando sull'oggetto non si dovesse aprire
il modulo di modifica, ma solo la lista dei dati 
associati, cliccare con il destro sulla lista e 
selezionare "Form di modifica geometria". Per 
far si che si apra in automatico accertarsi che 
sia selezionata al casella "Apri modulo 
automaticamente"

6.6  Modificare gli oggetti sulla mappa

6.6.1 Spostare oggetti

Con lo strumento di selezione che si ritiene più adatto (1)  si selezionano gli oggetti da spostare (2). 
Si seleziona lo strumento "Muovi elemento/i" (3), si clicca sopra gli oggetto selezionati e si 
trascinano nella posizione desiderata (4). Per annullare lo spostamento Ctrl + z
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6.6.2  Alterare la forma

Selezionare lo strumento "Strumento vertici" e cliccare su un punto della mappa che si vuole 
modificare (in modalità modificabile). Le crocette sui vertici si trasformeranno in quadratini rossi.

• Per spostare un punto => posizionarsi sopra il punto, fare click con il tasto sinistro e 
trascinarlo nella posizione desiderata

• per cancellare un punto => posizionarsi sopra il punto e fare click con il tasto sinistro. Il 
quadratino diventerà blu. A questo punto cancellarlo premendo il tasto Canc

• per aggiungere un punto => posizionare il cursore nella posizione desiderata e cliccare due 
volte con il tasto sinistro
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6.6.3 - aggiungere o sottrarre parti

Per ritagliare  un buco in una mappa
Dopo aver messo il layer in modalità modificabile:
1. Selezionare lo strumento "Aggiungi buco"
2. disegnare il buco e concludere il comando cliccando con il tasto destro
Attenzione: il buco deve essere completamente contenuto dentro un solo poligono
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Per eliminare  un buco in una mappa
Dopo aver messo il layer in modalità modificabile:
1. Selezionare lo strumento "Elimina buco"
2. cliccare all'interno del buco da eliminare.
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Per disegnare un buco in una mappa (cioè per ritagliare all'interno di un poligono un altro 
poligono)
Dopo aver messo il layer in modalità modificabile:
1. Selezionare lo strumento "Riempi buco"
2. disegnare il buco e concludere il comando cliccando con il tasto destro
3. modificare il "Forma di modifica geometria" (che si aprirà in automatico) con i dati relativi al 
nuovo poligono disegnato e confermare cliccando sul pulsante "OK"
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Per aggiungere una parte ad un oggetto sulla mappa
Dopo aver messo il layer in modalità modificabile:
1. Selezionare l'oggetto cui si vuole aggiungere una parte
2. selezionare lo strumento "Aggiungi parte"
3 disegnare la parte che si vuole aggiungere e concludere il comando cliccando con il tasto destro. 
Si possono aggiungere più parti allo stesso oggetto, formando così un oggetto detto "multiparte". 
Selezionando una delle parti che lo compongono, verranno selezionate anche tutte le altre.

87

2

1

3

1

2



Per eliminare  un una parte in un oggetto multiparte
Dopo aver messo il layer in modalità modificabile:
1. Selezionare lo strumento "Elimina parte"
2. cliccare sulla parte da eliminare. Se si clicca su un oggetto composto da una sola parte (ad 
esempio un solo poligono, o un solo punto o una sola linea) non succede niente.

6.6.4  Spezzare degli oggetti (solo poligoni o linee)

Dopo aver messo il layer in modalità modificabile:
1. Selezionare lo strumento "Spezza elemento"
2. tracciare la linea (o le linee) di taglio e concludere il comando cliccando con il tasto destro. 
Verranno tagliati solo gli oggetti attraversati completamente da una linea
a - b- c- d- e => nuovi poligoni 
Ciascun nuovo oggetto avrà associati i dati dell'oggetto spezzato.
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6.6.5 Unire oggetti (appartenenti allo stesso layer)

Dopo aver messo il layer in modalità modificabile:
1. Selezionare gli oggetti da unire
2. selezionare lo strumento "Unisci elementi selezionati" . Si aprirà automaticamente il form 
"Unisci attributi geometria"
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3. L'ultima riga in basso riporta i dati che verranno associati agli oggetti uniti e può essere 
modificata. 
In alternativa possono essere associati i dati di uno degli elementi selezionando la linea 
corrispondente e cliccando il pulsante sul modulo "prendi attributi dalla geometria selezionata" (4.)
Confermare con il pulsante OK. Se gli oggetti da unire sono adiacenti le linee che li dividono 
spariranno. Se nono lo sono verrà costruito un oggetto multiparte

6.6.6 Semplifica geometrie

Il comando (Vettore =>Strumenti di geometria => Semplifica geomoetrie) consente di ridurre il 
numero di vertici di un oggetto, a patto che non venga cambiata la geometria. In primo luogo, 
trascinare selezionare l'oggetto: i vertici saranno evidenziati in rosso mentre il colore della funzione 
cambierà e una finestra di dialogo in cui è possibile definire
una tolleranza della mappa (unità o pixel). QGIS calcola la quantità di vertici che possono essere 
eliminati mantenendo la geometria e utilizzando la tolleranza definita. Più alta è la tolleranza, più 
vertici possono essere cancellati.
La tolleranza utilizzata verrà salvata quando si lascia un progetto o quando si lascia una sessione di 
modifica. 

6.7 Trasferire i dati da una mappa all'altra

Gli elementi contenuti in un layer vettoriale possono essere tagliati, copiati ed incollati tra layer 
dello stesso progetto di QGIS a patto che i layer contengano lo stesso tipo di oggetti (non posso 
incollare punti in un layer di poligoni) e abbiano lo stesso sistema di coordinate. 

Per esempio se vogliamo copiare alcuni elementi da un layer ad un altro:
1. Caricare il layer dal quale vogliamo copiare gli elementi (layer sorgente)
2. Caricare o creare il layer nel quale vogliamo incollare gli elementi copiati (layer di destinazione)
3. Impostare entrambi i layer in modalità modifica 
4. Rendere attivo il layer sorgente cliccando sul relativo nome nella legenda
5. Selezionare gli elementi dal layer sorgente, dalla mappa tramite uno degli strumenti di selezione, 
oppure selezionando le linee di tabella corrispondenti

6. Cliccare sull'icona Copia elementi (oppure Ctrl + C)

7. Rendere attivo il layer di destinazione cliccando sul relativo nome nella legenda

8. Cliccare sull'icona Incolla elementi (oppure Ctrl + V)

9.Salvare e uscire dalla modalità modifica

Attenzione!!!!
Se il layer sorgente e quello di destinazione hanno differenti tabelle (ovvero differenti nomi e 
tipologia di campi) QGIS copia gli elementi nei campi corrispondenti mentre ignora i restanti. Se 
non si presta attenzione si rischia di perdere alcuni attributi, per cui si raccomanda di controllare che
il layer ricevente abbia le stesse colonne di tabella del layer  sorgente. 
Se layer sorgente e layer di destinazione hanno stesso sistema di proiezione, gli elementi incollati 
manterranno la stessa geometria, ma se il layer di destinazione ha un sistema di riferimento 
differente, questi verranno traslati e deformati.
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6.8  Compiti a casa

• Disegnare (senza impazzirci, ma assicurandosi che le geometrie siano corrette)  la mappa 
dell'uso del suolo negli anni '50 ricalcando la tavoletta IGM georeferenziata nel capitolo 
precedente, associando al vettore una tabella in cui per ogni poligono si riporta il tipo di uso.

• Incrociare l'uso attuale dell'area con quello degli anni '50 e evidenziare le aree in cui l'uso è 
cambiato. ATTENZIONE!!! questa consegna fa riferimento a quanto spiegato in tutti i 
capitoli precedenti, può essere svolta in molti modi diversi, ma è fondamentale che le 
tabelle dei due vettori siano strutturate in modo compatibile
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7 Stampare un progetto QGIS
Una volta predisposto un progetto in QGIS è importante rendere fruibili le informazioni contenute 
anche al di fuori degli “addetti ai lavori”. Il metodo più “tradizionale” è realizzare mappe stampate 
o mappe digitali statiche, cioè che contengono informazioni non modificabili. QGIS fornisce uno 
strumento per la stampa di tavole, che permette di visualizzare una o più mappe e corredarle con le 
informazioni necessarie alla loro comprensione. 

Si tratta di uno strumento pensato per un utilizzo in campo tecnico, quindi non offre molte 
possibilità di realizzare mappe artistiche o particolarmente suggestive, ma d'altra parte è facilitata la
rappresentazione delle informazioni collegate alle mappe e l'esplicitazione delle relazioni che 
intercorrono tra i diversi elementi.

C'è bisogno di una mappa stradale affidabile per raggiungere velocemente alcune località lontane 
dai percorsi principali. Servono quindi un reticolo geografico e riferimenti precisi alle coordinate 
utilizzate, un'indicazione di scala precisa e facilmente interpretabile, informazioni relative alla 
percorribilità di ciascun tratto di strada, alle distanze e ai tempi di percorrenza, indicazioni per 
raggiungere i principali servizi disponibili sul territorio, ...

Qual'è il modo migliore per rappresentare la pericolosità di alcune aree in frana? Si potrebbe 
utilizzare come sfondo la mappa delle pendenze, etichettare le aree in frana, inserire per 
ciascun'area una fotografia, visualizzare i dati collegati come linee di tabella, aggiungere un titolo 
e una descrizione per punti dei contenuti della carta...

Un progetto quindi non porta ad una sola mappa, ma ad una serie, permettendo di:

• realizzare una panoramica sui diversi argomenti

• approfondire uno stesso tema su scale diverse

• evidenziare le relazioni di un tema con tutti gli altri

• selezionare solo alcune informazioni rilevanti per ogni tematiche

• …..

7.1 Visualizzare un progetto nel compositore di stampe

Lo strumento per la realizzazione di mappe statiche è il compositore di stampe che opera  in 
parallelo con la finestra principale di QGIS. 

Menu “Progetto” => “Nuova composizione di stampa”

oppure si clicca sull'icona corrispondente (1) 

=>  si indica un titolo per il  nuovo layout di stampa che si va a creare (2)

=> “OK”
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Si apre la finestra del compositore di stampe. La parte centrale è dedicata alla visualizzazione della 
stampa, la parte superiore contiene i menu e le icone delle principali funzioni e la parte destra 
contiene i comandi per modificare e personalizzare i diversi elementi della mappa. Di seguito sono 
presentate le icone delle principali funzioni.

Aggiungi mappa Nuovo compositore

Aggiungi immagine Duplica compositore

Aggiungi etichetta Gestore composizione

Aggiungi legenda Salva come modello

Aggiungi nuova barra di scala Blocca gli oggetti selezionati

Aggiungi freccia Sblocca tutti gli elementi

Aggiungi tabella attributi Stampa

Add shape (rettangolo/triangolo/ellisse) Esporta come immagine

Scegli /Sposta oggetto Esporta come SVG

Sposta contenuto elemento Esporta come PDF

Raggruppa oggetti

Rimuovi raggruppamento (separa)
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7.2 Impostare il layout di stampa

Una volta creato un layout di stampa conviene subito impostare la dimensione del foglio. Da questa 
infatti dipenderà la scala di stampa e lo spazio a disposizione per i vari elementi da aggiungere alla 
mappa vera e propria.

Nella parte destra della finestra 

=> scheda "Composizione" => click su "Page size"=> si sceglie il formato della pagina da stampare e 
l'orientamento (verticale o orizziontale)

=> scheda "Composizione" => click su "Export settings" => si indica la risoluzione della stampa (di 
default è indicato 300 dpi, che è già una risoluzione molto buona per la stampa)

• se si intende salvare i diversi presenti nella composizione di stampa su diversi livelli, 
accertarsi che l'opzione “Stampa come raster" non sia spuntata. In caso contrario tutti gli 
oggetto saranno salvati come immagini raster su un unico livello. In effetti, ad oggi, la 
possibilità di mantenere i livelli nel file di stampa non funziona ancora molto bene e 
soprattutto nel caso di mappe grandi, pesanti o con uno sfondo raster, è necessario spuntare 
l'opzione “Stampa come raster”

• se si vuole ottenere come "stampa" un'immagine raster georeferenziata, si spunta l'opzione 
"Crea world file".

Nel compositore di stampe si può ora visualizzare il progetto QGIS come appare nella schermata 
principale (layer accesi, stili, sfondi, ecc.):

Menu “Layout” => “Aggiungi mappa” (oppure  )

=> si disegna sul “foglio” una finestra grande quanto lo spazio che si desidera occupare con la 
mappa

Nello spazio delimitato dalla finestra comparirà la mappa visualizzata nel progetto. Conviene 
adesso impostare la scala di rappresentazione nella parte destra del compositore.
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Scheda “Proprietà oggetto” => click su “Proprietà principali” => “Scala”

Anche se è possibile aggiungere una barra di scala grafica conviene sempre impostare la stampa 
ad una scala nominale “standard” per facilitarne la comprensione a colpo d'occhio (meglio una 
mappa in scala 1:50.000 piuttosto che in scala 1:67.289)

Si può modificare la grandezza della finestra contenente la mappa cliccandovi sopra e trascinando le
maniglie che compaiono sugli angoli e a metà dei lati della finestra.

ATTENZIONE! Se si desidera stampare una mappa che abbia come sfondo una mappa collegata 
via web (ad esempio tramite il plugin OpenLayers o tramite un servizio WMS) la finestra di 
stampa deve coincidere con l'estensione del foglio, altrimenti sfondo ed elementi disegnati 
risulteranno sfalsati.

• Per spostare la finestra della mappa:
Menu “Layout” => “Scegli /sposta oggetto” (oppure  ) => si clicca in un punto della 

finestra e la si trascina nella posizione desiderata

• Per spostare il contenuto visualizzato all'interno della finestra della mappa
Menu “Layout” => “Sposta contenuto elemento” (oppure  ) => si clicca in un punto 

della finestra e si trascina il contenuto nella posizione desiderata

7.3 Aggiungere alcuni elementi utili

Per completare la mappa con una serie di elementi utili alla sua comprensione, si segue il criterio 
generale di aggiungerli tramite lo specifico comando nel menu "Layout", selezionarli e  
personalizzarli attraverso la scheda "Proprietà oggetto" nella parte destra del compositore di 
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stampe.

Di seguito sono presentati alcuni esempi

7.3.1 Aggiungere una legenda

Menu "Layout" => "Aggiungi legenda" oppure   => si clicca nel punto del foglio in cui si vuole

posizionare la legenda. 

Comparirà una legenda con tutti gli elementi contenuti nel progetto, siano essi visibili o meno. 
Soprattutto nel caso di progetti molto complessi è assolutamente spropositata, quindi va adattata 
attraverso le opzioni nella scheda “proprietà oggetto”

La prima cosa che conviene fare è eliminare dalla legenda tutte le voci che si riferiscono a elementi 
non visibili (ad esempio layer spenti o completamente coperti da altri) o non rilevanti (ad esempio 
relativi alle mappe di sfondo). Quando sono rimaste solo quelle effettivamente utili si può 
modificare il testo, la posizione, lo stile dei simboli e del testo, la spaziatura e la disposizione delle 
voci

• Eliminare voci
“Proprietà oggetto” =>  click su “Oggetti legenda” => accertarsi che la casella “aggiorna 
automaticamente” NON sia spuntata =>  si selezionano le voci da eliminare (si può fare una
selezione multipla tenendo schiacciati i tasti Maiusc o Ctrl) => si clicca sull'icona  

• Modificare il testo delle singole voci della legenda
“Proprietà oggetto” =>  click su  “Oggetti legenda”  => si seleziona la voce di cui si vuole 
modificare il testo => si clicca sull'icona   => si scrive il nuovo testo nella casella 
“Proprietà oggetti in legenda” 

Per eliminare un testo in legenda è sufficiente cancellare quanto scritto nella casella “Proprietà 
oggetti in legenda” 
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• Cambiare l'ordine delle voci 
“Proprietà oggetto” =>  click su  “Oggetti legenda” => si seleziona la voce da spostare => 
click sull'icona   o   per spostare in basso o in alto la voce selezionata

• Aggiungere voci alla legenda 
“Proprietà oggetto” =>  click su  “Oggetti legenda” => si seleziona la voce da spostare => 
click sull'icona   => compare la lista dei layer visualizzati nel progetto => si sceglie 
quello che si vuole aggiungere alla legenda => OK => il layer aggiunto comparità in fondo 
alla legenda

• Modificare lo stile del testo
“Proprietà oggetto” =>  click su  “Caratteri” => si seleziona la voce da spostare => click 
sul pulsante relativo al tipo di testo di cui si desidera modificare lo stile:

Carattere del titolo => modifica lo stile del titolo delle legenda
Carattere del sottogruppo => modifica lo stile del nome di un elemento
Carattere del gruppo => modifica lo stile del nome di un gruppo
Carattere dell'oggetto => modifica lo stile di un tematismo

• Modificare lo stile dei simboli
“Proprietà oggetto” =>  click su  “Simbolo” => si impostano le dimensioni dei simboli 

Ulteriori aggiustamenti sono inoltre possibili attraverso le altre opzioni visualizzate nella scheda 
“Proprietà oggetto”.

Per eliminare una legenda dal compositore di stampe è sufficiente selezionarla e premere il tasto 
backspace (freccia verso sinistra sulla tastiera)

7.3.2 Aggiungere una barra di scala

Menu "Layout" => "Aggiungi nuova barra di scala" oppure   => si clicca nel punto del foglio 

in cui si vuole posizionare la barra di scala. 

Di default la barra di scala è divisa in 6 segmenti, due a sinistra dello 0 e quattro a destra. Per 
chiarezza questa struttura potrebbe essere modificata, ad esempio eliminando le due prima dello 
zero 

“Proprietà oggetto” =>  click su “Segmenti” =>  si indica il numero di unità che si desidera avere 
prima e dopo dello zero
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Si può quindi modificare il tipo di barra, l'unità di misura, lo stile della barra e dei numeri, ecc.

• Modificare il tipo di barra
“Proprietà oggetto” =>  click su  “Proprietà principali” => dal menu a tendina “Stile” si 
sceglie itl tipo di barra da visualizzare

• Modificare lo stile della barra
“Proprietà oggetto” =>  click su  “Visualizza” => variando i valori nelle caselle di testo si 
modifica la distanza della barra dal bordo della “finestra, la distanza dei numeri dalla barra e
lo spessore delle linee della barra stessa. Il colore della barra e lo stile dei numeri invece si 
possono modificare dalla scheda “Proprietà oggetto” =>  click su  “Caratteri e colori” 

Ulteriori aggiustamenti sono inoltre possibili attraverso le altre opzioni visualizzate nella scheda 
“Proprietà oggetto”

Per eliminare una barra di scala dal compositore di stampe è sufficiente selezionarla e premere il 
tasto backspace (freccia verso sinistra sulla tastiera)

7.3.3 Aggiungere un'immagine

Questa funzione permette di visualizzare nel compositore di stampe immagini raster o vettoriali 
esterne al progetto (fotografie, disegni, loghi, ecc.).

Menu "Layout" => "Aggiungi immagine" oppure   => si clicca nel punto del foglio in cui si 

vuole posizionare l'immagine e si trascina fino alla dimensione desiderata. Apparirà un riquadro 
vuoto in cui verrà contenuta l'immagine.

“Proprietà oggetto” =>  click su  “Proprietà principali” => “Sorgente dell'immagine” => click sul
pulsante con i tre puntini = si va a selezionare l'immagine da inserire.
Siccome l'immagine può non essere della stessa dimensione del riquadro disegnato sul foglio, è 
possibile ridimensionarla secondo diversi criteri riportati nel menu a tendina “Modalità di 
ridimensionamento” e posizionarlo all'interno del riquadro con le diverse opzioni del menu a 
tendina “Posizione”.

Se si desidera aggiungere un disegno vettoriale (ad esempio il simbolo delle farmacie, o i segnavia 
lungo un percorso)
Proprietà oggetto” =>  click su  “Cerca cartelle” => compare l'anteprima di una serie di simboli 
vettoriali => se ne seleziona uno e questo comparirà nel riquadro indicato. 

Questi disegni fanno parte di una libreria di simboli preinstallata in QGIS, comunque, se si desidera 
inserire in una stampa altri simboli vettoriali è sufficiente salvarli in formato .svg (Scalar Vector 
Graphics, formato Open compatibile con i più comuni software di grafica)  e, cliccando sul tasto 
“Aggiungi”, aggiungere alla lista “Percorso di ricerca per le immagini” la posizione della cartella 
in cui sono salvati. Per caricarli nel compositore di stampe:
 Proprietà oggetto” =>  click su  “Cerca cartelle” => “Percorso di ricerca per le immagini” => si 
scorre la lista fino ad incontrare la cartella  in cui sono salvate le immagini che si desidera caricare

Per eliminare un'immagine dal compositore di stampe è sufficiente selezionarla e premere il tasto 
backspace (freccia verso sinistra sulla tastiera)
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7.3.4 Aggiungere una tabella attributi

Questa funzione permette di aggiungere alla stampa la vista della tabella collegata ad un layer 
presente nel progetto (visualizzato nel compositore di stampa o meno).

Menu "Layout" => "Aggiungi tabella attributi" oppure   => si clicca nel punto del foglio in cui 

si vuole posizionare la tabella. Verrà visualizzata l'intestazione della tabella collegata al primo layer 
vettoriale in ordine alfabetico presente nel progetto.

Proprietà oggetto” =>  click su  “Proprietà principali” => “Vettore” => si sceglie dal menu a 
tendina il vettore di cui si desidera visualizzare la tabella nel compositore di stampe. Verrà quindi 
visualizzata l'intestazione di questa. Trascinando verso il basso il bordo dell'intestazione vengono 
via via visualizzate le righe successive. Se la tabella è molto lunga, naturalmente, se ne potrà 
visualizzare solo una parte.

Proprietà oggetto” =>  click su  “Proprietà principali” => “Attributi...” =>  si apre la finestra 
“Seleziona attributi”. Nella parte superiore si può aggiungere colonne alla tabella (icona ), 

eliminarle (icona ) o spostarle (icone  e  ).

Nella parte inferiore  invece si impostano i criteri secondo cui ordinare i dati nella tabella.

Selezionare il nome del campo => selezionare il criterio di ordinamento => click su 

ATTENZIONE! Con queste operazioni non si modifica la tabella nel progetto, ma solo la 
visualizzazione nel compositore di stampe 

Nella scheda “Proprietà oggetto” sono inoltre disponibili diversi strumenti per modificare lo stile 
dalla tabella visualizzata.

Per rimuovere una tabella dal compositore di stampe è sufficiente selezionarla e premere il tasto 
backspace (freccia verso sinistra).

7.4 Stampare più mappe

Nel compositore di stampe si visualizza quello che è visibile nel progetto. Quindi, se nel progetto si
cambia l'ordine dei layer, o lo stile o vengono modificati dei dati, anche il layout di stampa ad 
esso collegato cambierà.

Per stampare più aspetti dello stesso progetto, quindi, conviene predisporre e salvare più layout di 
stampa a seconda degli elementi che si intende “stampare”.

Se invece si desidera stampare più mappe presenti nel progetto nello stesso layout di stampa:

si crea un nuovo compositore e si impostano le dimensioni del foglio e la risoluzione dell'output=>

=> menu “Layout” => “Aggiungi mappa” => si disegna una finestra 

=> si ripete questo passaggio per il numero di mappe che si desidera visualizzare nello stesso 
layout. In ciascuna finestra comparirà la stessa mappa. Selezionando di volta in volta ciascuna 
finestra sarà possibile impostare la scala di ciascuna mappa e la posizione della mappa all'interno 
della finestra ed eventuali elementi “accessori” (testo, immagini, ecc.). 

Modificando il progetto, le modifiche saranno riportate in tutte le mappe presenti nel layout 
di stampa
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Per bloccare la visualizzazione di una mappa, cioè renderla indipendente dal progetto:
Selezionare la finestra della mappa => “Proprietà oggetto” => si spunta la casella “Blocca i layers 
per la mappa”. In questo modo i layers visualizzati nel layout di stampa resteranno sempre gli 
stessi, anche se quelli visualizzati nel progetto cambieranno. Tuttavia, se si cambia lo stile ad un 
layer nel progetto, se questo è visualizzato nel layout di stampa, verrà aggiornato anche lì. Per 
rendere anche gli stili indipendenti dal progetto è necessario spuntare la casella “Blocca gli stili dei 
layer per gli oggetti della mappa”.

Modificando ora il progetto verranno aggiornate solo le mappe non “bloccate.

Per ciascuna mappa si può quindi aggiungere una legenda, mantenendo di volta in volta solo le voci
effettivamente presenti.
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Per aggiungere una barra di scala in ogni mappa:
Menu “Layout” => “Aggiungi barra di scala” => si clicca nel punto in cui si desidera posizionare 
la barra.    ATTENZIONE! Accertarsi che nella scheda “proprietà oggetto” => Proprietà principale 
=> Mappa =>  accertarsi che sia riportata la mappa sulla quale si sta effettivamente lavorando,
altrimenti la scala potrebbe risultare falsata.

Si può quindi impostare lo stile della barra di scala e ripetere l'operazione per ogni finestra
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7.5 Esportare un layout di stampa

Il layout di stampa ottenuto può quindi essere inviato direttamente alla stampante, ma può essere 
anche salvato come file pdf, immagine o disegno vettoriale.  

• Per stampare direttamente:  

• Per salvare come immagine:  ATTENZIONE! in caso di layout particolarmente 

grandi o pesanti (alta risoluzione, presenza di sfondi, presenza di fotografie, ecc.) 
l'immagine raster risultante dall'esportazione può contenere aree bianche o non essere 
completa. Per superare questo inconveniente si suggerisce di lanciare l'esportazione a PC 
freddo e, nel caso il risultato non migliorasse, di diminuire la risoluzione.

• Per esportare in formato SVG (disegno vettoriale):   Gli oggetti vettoriali vengono 

esportati come vettori, mentre le immagini raster, se grandi, vengono suddivise in “tiles”, 
cioè riquadri e incluse così nel disegno.  ATTENZIONE! Questa funzione è ancora in 
corso di sviluppo, per cui può non essere molto stabile o non dare risultati di buona 
qualità. Nel caso si suggerisce di “stampare” il layout come file pdf (ad esempio utilizzando
PDF Creator, o Adobe Acrobat ).

• Per esportare in formato .pdf:  Per mantenere i livelli nel file esportato accertarsi che 

non sia spuntata la casella:  “Composizione” => “Export settings” => “Stampa come raster”.
Aprendo il file risultante in un software di grafica i diversi oggetti sono indipendenti (il 
risultato è molto simile alla funzione per esportare in formato .svg). Anche in questo caso si 
potrebbero verificare problemi a esportare mappe grandi o complesse. Questo può essere 
superato “stampando” il layout come file pdf (vedi sopra), unendo i livelli attraverso 
l'opzione stampa come raster”, oppure, come nel caso dell'esportazione come immagine, 
lanciando l'esportazione a PC freddo e diminuendo la risoluzione.

E' infine possibile esportare il layout di stampa, cioè la disposizione degli elementi per poterla 
utilizzare con altre mappe dello stesso progetto o di altri progetti. 

Menu “Compositore” => “Salva come modello” oppure 

Per inserire in un compositore di stampa gli elementi salvati in precedenza come modello:

Menu “Compositore” => “Aggiungi oggetti da modello” oppure 

7.6  Compiti a casa

• Preparare una “cartina” turistica della Val Bisagno (rilievo del terreno, strade, località, 
legenda, ecc. in generale tutte le informazioni per renderla comprensibile e “accattivante”)

• Preparare un  layout di stampa che permetta di confrontare tre caratteristiche principali della 
Val Bisagno
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